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Foreword 

This manual is written for DynoWare, a general-purpose 
data acquisition and analysis software. 
 
Information in this document is subject to change without 
notice. Kistler reserves the right to change or improve its 
products and make changes in the content without 
obligation to notify any person or organization of such 
changes or improvements. 
 
©2002 … 2013 Kistler Group. All rights reserved. Except as 
expressly provided herein, no part of this manual may be 
reproduced for any purpose without the express prior 
written consent of Kistler Group. 
 
 
 
Kistler Group 
Eulachstrasse 22 
8408 Winterthur 
Switzerland 
Tel. +41 52 224 11 11  
Fax +41 52 224 14 14 
info@kistler.com 
www.kistler.com 
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1. Introduction 

We thank you for choosing a Kistler quality product. Please 
take the time to thoroughly read this instruction manual. It 
will help you with the installation, maintenance, and use of 
the DynoWare system.  
To the extent permitted by law Kistler does not accept any 
liability if this instruction manual is not followed or 
products other than those listed under Accessories are 
used. 
DynoWare is an easy-to-use data acquisition and mani-
pulation program. The typical Windows controls apply to 
the graphs and dialog boxes in DynoWare. This section will 
give you a quick overview of the capabilities of DynoWare. 
 
The menu bar is your access to all areas of DynoWare. It is 
divided into sections covering specific functions such as file 
handling, data acquisition configuration, hardware confi-
guration, data viewing, window control, and obtaining 
help. In addition to the menu bar, there is a toolbar similar 
to those found in word processing and spreadsheet 
programs. The toolbar consists of icons that execute a 
specific function when clicked.  
The user has full control over data acquisition. Sampling 
rate and length of trials, as well as amplifier range and 
trigger options are all easily accessible. The units of data 
acquisition can be customized to the desired physical data 
being measured. 
 
The graphs are designed to be easy to read, and can be 
fully customized. The number of graphs to view is flexible, 
along with default parameters so each trial is readily 
viewed in a format that is most useful to the user. 
 
If you have questions at any time while in DynoWare, 
simply press the F1 key and the DynoWare on-line help 
window appears. Help is also available from the menu bar. 
 
Kistler offers a wide range of products for use in measuring 
technology: 
 Quartz crystal sensors for force, torque, strain, pressure, 

acceleration, shock, vibration and acoustic-emission 
 Piezoresistive pressure sensors and transmitters 
 Signal conditioners, indicators and calibrators 
 Electronic control and monitoring systems as well as 

application-specific software for measuring technology 
 
Kistler also develops and produces measuring solutions for 
the application field engines, vehicles, manufacturing, 
plastics and biomechanics.  
Our product and application brochures will provide you 
with an overview of our product range. Detailed data 
sheets are available for most products. 
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1.1 Getting Software Help 

DynoWare software takes advantage of an online help 
system to offer you quick assistance.  
 
To receive immediate help from wherever you are in 
DynoWare, press the F1 key and a window will pop up 
with specific advice about where you currently are in the 
software. 

 
Help is also accessible through the menu bar found at the 
top of the screen. 
 
If you need additional help beyond what can be found 
either on-line or in this manual, please contact Kistler's 
extensive support organization. 
 

 
Fig.  1:  Help is available by pressing the F1 key or by 
 selecting the Help from the menu 

1.2 Customer Support 

The worldwide Kistler service organization is available for 
any special questions or problems that you may have after 
your careful study of these instructions.  
 
Note, refer to sections 1.3 through 1.6 for general policies 
on customer support. Before you call, please be ready to 
fully explain your problem. If you are experiencing a 
problem with DynoWare software, please try to duplicate 
the problem and take a snapshot of the screen by pressing 
the "print screen" button. This copies the screen to the 
clipboard so that it can be pasted into a word processing 
program and printed. You can e mail this picture to Kistler. 
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1.3 Service and Assistance 

The customer is responsible for proper DynoWare 

installation and operation. DynoWare must be installed as 
per instructions provided in sections 4 and 5. If modifi-
cations to these instructions are necessary for a particular 
purchaser site, Kistler recommends the purchaser contact a 
Kistler representative for input and advice regarding these 
changes. 
 
Installation problems and subsequent system performance 
difficulties can be adverted by timely communication. 
Often, questions can be answered through email or 
telephone conversations. The purchaser is encouraged to 
email or call the appropriate Kistler organization in the 
event of such questions. 
 
We welcome comments and suggestions for future 
features and enhancements. 

1.4 License Agreement 

Please refer to the Software License Agreement packet 
containing your DynoWare software and to the license 
presented during installation. This packet thoroughly 
details the Software License Agreement.  
 
You may permanently transfer the software to another 
user provided you notify Kistler in advance, transfer the 
documentation and all disks, and notify the new user of 
the terms and conditions of the license agreement. 

1.5 Warranty 

Kistler warrants DynoWare to be free from defects in 
material and workmanship as stated in the software license 
agreement. It is warranted only under normal use and 
service. The period of warranty is twelve (12) months from 
date of shipment. 
 
When returning items under warranty, said equipment 
shall be returned to Kistler Instruments prepaid. Full details 
relative to the claim or malfunction shall accompany the 
shipment. No action will be taken until these details are 
received. Please contact Kistler or your Kistler represen-
tative for a Return Authorization Number before returning 
goods. 
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Settlement will be made at Kistler’s discretion, either 
through repair or replacement of the item in question or 
through issuance of full credit. Damage occurring through 
misuse or mishandling, will not be covered by this 
warranty. 
 
This warranty is in lieu of all warranties expressed or 
implied, and of all obligations or liabilities on the part of 
Kistler Instruments for damages following the use or 
misuse of items supplied. Any unauthorized disassembly or 
attempt at repair shall void this warranty. 
 
No agent or representative is authorized to assume for the 
Corporation any liability except as set forth within this 
warranty document. 

1.6 Claims 

Claims relating to goods delivered must be made within 14 
days of receipt of goods. After fault determination by 
Kistler, settlement will be made either by the carrier, 
insurer, or Kistler. Means will be through replacement, 
repair or credit 
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2. Important Information 

Please practice common sense safety rules at all times. 

2.1 For your Safety  

Prior to any installation and repair work or cable changes, 
you must disconnect all power sources from the instru-
ments. 
Observe all local safety regulations concerning the hand-
ling of line-powered electrical and electronic equipment. 
When it must be assumed that safe operation is no longer 
possible, the computer, charge amplifier, etc. must be 
taken out of operation and secured against unintentional 
use. 
Whenever opening covers or removing parts, except where 
this can be done by hand, use caution where parts under 
hazardous voltage are exposed. 

2.2 Warning 

Any breakage of the ground conductor inside or outside 
the instruments, or loosening of the ground conductor 
connection may render the instrument dangerous. 
 
The power plug must be inserted in to a socket with a 
ground connector. The protection must not be nullified by 
an extension line lacking a protective ground connector. 
 
When changing the signal conditioner fuses, only the 
standard type with the specified amperage rating must be 
used. Use of repaired fuses or short-circuiting the fuse 
holder is expressly forbidden. 

2.3 How To Use This Manual 

This manual will take you through the installation and 
setup of the DynoWare software, and a complete 
reference to all of the features of this software. 
 
If you are eager to begin operation of DynoWare we 
recommend section 5 of this manual for a quick start 
guide. Remember that on-line help is always available by 
pressing the F1 key from anywhere in the software. 
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3. Description of DynoWare 

3.1 General 

DynoWare is a general-purpose data acquisition and 
display software package suitable for cutting force and 
general sensor / dynamometer applications. DynoWare lets 
you quickly setup, record, and display reaction forces and 
torques. Although development concentrated on 
measurement of cutting forces in mechanical machining, 
the measurement data acquisition and analysis functions 
can also be used for other measurement tasks. Depending 
on the data acquisition card, up to 28 channels are 
available for measurement acquisition. The software 
supports data acquisition cards for the PCI bus, PC cards 
for notebooks and the USB data acquisition system for 
DynoWare Type 5697A. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  2:  The DynoWare splash screen appears for a few  
 seconds when the application starts 
 
All components have been included with the system (i.e., 
software, cables, and A/D card). A typical piezoelectric 
measuring chain consists of many components, each 
specific to the user’s application. These include: 
 Dynamometer 
 Charge amplifier 
 Data acquisition system for DynoWare (ex.Type 5697A 

with integral A/D card from Measurement Computing 
Inc) 

 DynoWare software and manual 
 All necessary cabling 
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3.2 System Requirements 

Recommended Computer Specifications: 
 Microsoft Windows® XP Professional, Vista, Windows® 

7 (32 bit and 64 bit  versions) 
 Pentium PC, 1 GHz or higher 
 At least 512 MB of RAM  
 Graphics card with at least 800x600 pixels and 256 

colors 
 At least 100 MB of free hard-disk space 
 One free slot for the A/D card (PCI) 
 or 
 One USB 2.0 port for DAQ-System Type 5697A 
 Adobe Reader for printing out measurement data 
 Color printer (recommended) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Windows® is a registered trade mark of Microsoft 
Corporation. 
Adobe® Acrobat® Reader® is a registered trade mark of 
Adobe. 
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4. Installation  

This chapter will show you how to install the data 
acquisition card, the DynoWare software, configure the 
data acquisition hardware, as well as connect the cable 
from the A/D card to the signal conditioner. 

4.1 DynoWare Software Installation 

DynoWare software consists of one CD-ROM media disk 
containing an automatic installation procedure. To install 
DynoWare perform the following procedure:  
 

 

Some antivirus software packages can adversely affect 
the DynoWare installation process. Temporarily disable 
your antivirus software prior to installation. 

 
1. Insert DynoWare Disk into your CD-ROM drive.  
 

 

With many CD-ROM systems the Autorun function is 
activated and the splash routine opens the installation 
window automatically as soon as the CD-ROM is 
recognized. In this case you can go straight to step 4. 

 
2. (If your CD-ROM is setup to auto play you can skip 

this step.) From the Start menu, choose Run, in the 
dialog box, type "d\:kistlersetup" (without the 
quotes) substitute your CD-ROM drive letter for "d" 
above, choose OK. 

3. The "kistlersetup.exe" program presents general 
information on installing DynoWare. We recommend 
reading this information prior continuation.  The op-
tions presented are to "Browse Technical Notes", 
"Browse Documentation", "View System Require-
ments" and "Install DynoWare Software". 

4. When ready to install DynoWare, select the "Install 
DynoWare Software" option.  

5. Follow the onscreen instructions.  
 
 

Fig.  3: Start Setup program 
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Alternative method of installation  

Another way of installing the program if it is not started 
automatically is to manually click the file 
'kistlersetup.exe' in the root folder of the CD-ROM. 
The installation window is opened and you can go 
straight to step 4. 

 
The first installation screen will present you with a choice 
of the default language.   
 

 

You can switch the user language of DynoWare at any 
stage of operation. 

 

 
Then you will be presented the License Agreement. 
Confirming acceptance displays the readme and user 
information, and the destination folder for programs and 
data can be specified. The Setup Type dialog allows you to 
choose between Complete and Custom installation. 
Normally, Setup Type should be set to "Complete" 
 
The Setup Type "Complete" will install the DynoWare 
application, the HASP Runtime License Drivers, the driver 
of the data acquisition system and the driver of the USB 
interfaces to the connecting box Type 5697A. 
 

 

We always recommend to install the "complete" 
version of this software. 

 
Pressing "Install" starts the actual installation. Follow the 
instructions. Finally, to apply the drivers the PC must be 
restarted. 
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4.2 HASP Key Installation 

 

 

 
Without a hardware key or "dongle"  DynoWare only 
starts in the demonstration mode. 
 

 
The dongle (HASP key, runtime license) is needed to 
acquire data and exploit the various possibilities offered by 
DynoWare. This dongle is the only way of legitimizing the 
software.  
 
 
 
 
 
 
 
 
Install the runtime license as follows: 
 
1. After installing DynoWare insert the dongle in a free 

USB port on your computer. 
 
The relevant drivers are installed automatically. 
 
 
 
 
 
 
 

 

If you are using the DAQ-System Type 5697A you can 
go straight to section 4.3.3. 
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4.3 Installing Data Acquisition Card 

The data acquisition card should be installed by someone 
who is familiar with installing internal computer 
peripherals. If you are unsure how to open your personal 
computer or if your system is warranted under a service 
contract, please have a qualified technician install the card. 
 

 

 
The installation CD-ROM contains card specific 
Installation Technical Notes for the various A/D card 
supplied by Kistler. See these technical notes as well as 
the information below. The procedure to install and 
configure the card is highly dependent on the specific 
card purchased with DynoWare. 

 

 

Make sure to disconnect the power source from your 
computer before opening it. 

 

 

Protect the system and A/D card from static discharge 
by touching the computer chassis to ground yourself 
prior to handling the A/D card. 

4.3.1 PCIM-DAS1602/16  

The following steps are recommended for A/D card 
installation: 
 

 

Make absolutely sure to take note of the technical 
information in the file K20.302-4e PCIM-DAS1602.pdf 
on the installation CD before inserting the PCIM-
DAS1602/16 card. 

 
1. With the power off and the power cord unplugged, 

remove the computer PC cover to gain access to the 
system's expansion slots. Avoid touching any compo-
nents inside the PC. 

2. Touch the metal computer chassis prior to handling the 
A/D card to avoid inducing static shocks. 

3. Set the on-board switch to BIP (bipolar) (see your card 
manual). 

4. Set the on-board switch to 8 channels (differential). 
5. Select an available PCI slot, and remove the back plate 

metal covers with a screwdriver. 



 Installation 
 
 

2825A_002-195e-10.13-Korr.Ex.03  Page 17 
 

6. Carefully insert the A/D card into the slot making sure 
that it seats correctly into the computer. Replace the 
slot cover screw, fastening the edge of the card to the 
chassis of the PC. 

7. With the A/D card properly installed, replace the cover 
of the computer and tighten the screws. 

8. Restart the computer. The card will be auto-detected by 
the plug-and-play operating system. If prompted for 
the driver, insert the DynoWare CD-ROM containing 
the CBI95.INF file. 

9. Follow the instructions in sections 4.4.1. 
 

4.3.2 PC-CARD-DAS16/16 

The following steps are recommended for A/D card 
installation: 
 

 

 
Make absolutely sure to take note of the technical 
information in the file K20.302-6e PC-CARD-DAS16.pdf 
on the installation CD before inserting this card.  

 

 
1.  Ensure DynoWare is fully installed (see 4.1). 
2. With the power on and Windows running, insert the 

PC-CARD-DAS16/16 into a PCMCIA type II slot.  
3. Windows will recognize this device as a new device 

and will prompt you to enter the disk with the 
manufacturer's drivers. This is the CD-ROM with the 
DynoWare installation program and containing the 
file CBI95.INF. Insert the disk into the drive and con-
tinue. 

4. Windows will load the necessary PC-CARD drivers 
and configure the PC-CARD-DAS16/16. 

5. Follow the instructions in section 4.4.2 
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4.3.3 Type 5697A DAQ-System for DynoWare (USB2533)  

 
The following procedure is recommended for installing the 
A/D card: 

 

 

Make sure to take note of the technical information in 
the file K20.302-11e Type 5697 DAQ.pdf on the 
installation CD before inserting this card. 

 
 
1. Ensure DynoWare is completely installed (see section 

4.1). 
2. Power up the data acquisition system with the switch 

in the OFF position. The outer ring of the connector 
must be tightened clockwise beforehand. 

3. Connect the acquisition system to the PC with the 
included USB cable. 

4. Insert the USB runtime license dongle (HASP key) into 
the matching slot in the data acquisition system. 

5. Switch the data acquisition system for DynoWare on 
(ON position) after starting the Windows operating 
system. 

6. Windows detects the device and installs its drivers. If 
Windows is searching for drivers, insert the DynoWare 
installation CD-ROM then follow the instructions. 

7. Windows loads the required drivers and configures 
them for the Data Acquisition System Type 5697A. 

8. Follow the instructions in section 4.4.3. 
 

 

Older cards can be activated manually. Whenever the 
DAQ-System Type 5697A is removed from the 
computer and reconnected, or switched off and on 
again, INSTACAL must be started to allow loading of the 
necessary drivers. 
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4.4 A/D Card Configuration 

The software configuration process involves two steps. In 
the first the card and data acquisition drivers are 
configured with INSTACAL. This requires certain routines 
from the manufacturer of the acquisition card. In a second 
step this setup must be exported to DynoWare. 
 
INSTACAL  can be started under the Measurement 
Computing group of programs. The program configures 
the driver and A/D card setup for you. Look for the 
Measurement Computing group of programs (Start menu 
→ (All) Programs) and choose the Instacal icon. 
 

 
 
Fig.  4: Instacal board configuration program 
 

 

The Instacal card configuration program will auto-
matically identify and plug-and-play capable data 
acquisition cards. Manually add any non plug-and-play 
cards. 

 

 

Selecting the Instacal program Calibrate menu option 
will reconfigure the card's factory calibrated parameters 
and affect the accuracy of your measurements. Do Not 
run the Calibration routine. 

 
 

Instacal will automatically identify any installed plug-and-
play cards. Any non plug-and-play card will have to be 
manually added by selecting the Install menu option and 
then selecting the desired card from the list. Instacal should 
be run any time a card is removed from a computer (even 
for PCMCIA cards). 
 
 
 
 
 

Fig.  5: Configuration for the PCIM-DAS1602/16 
 
 

 

 

DynoWare will use the card configured in Instacal as 
board zero. By default, the "DEMO-BOARD" is installed 
as board zero. Remove the "DEMO-BOARD" and 
reconfigure the desired card to be number zero (See 
section 4.5). This applies to all of the A/D cards listed 
here. 
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Once the card is installed it will need to be configured. 
Right click on the card and select Configure… or double 
click the card. 

4.4.1 PCIM-DAS1602/16 

See technical note K20.302-4e PCIM-DAS1602.pdf contai-
ned on the installation CD-ROM for detailed information. 
 
The following parameters should be set: 

Channels Select 8 channels, differential mode (note: Instacal setting 
must match hardware switch setting).    

Input Mode Bipolar (note: Instacal setting must match hardware switch 
setting). 

Clock Speed Select 10 MHz (note: Instacal setting must match hardware 
switch setting). 

4.4.2 PC-CARD-DAS16/16 

See technical note K20.302-6e PC-CARD-DAS16.pdf con-
tained on the installation CD-ROM for detailed infor-
mation. 
 
The following parameters should be set: 

Channels Select 8-channel differential mode (note: Instacal auto-
matically controls hardware setting). 

Input Mode Bipolar (note: Instacal automatically controls hardware 
setting). 

Clock Speed Select 10 MHz (note: Instacal automatically controls hard-
ware setting). 
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4.4.3 Type 5697A DAQ-System for DynoWare (USB2533) 

See technical information K20.302-11e Type 5697 
DAQ.pdf on the installation CD-ROM for more detailed 
information. 
 
The following values must be set: 

Channels Choose 64 channels, single-ended mode (note: Instacal 
automatically controls the hardware setup).    

 

 If the card is not set to 64 channels single-ended, the 
following message is displayed when DynoWare is started 
up: 

 DynoWare automatically switches to 64 channels single-
ended. 

4.5 Set Card Number to Zero 

DynoWare operates using the Instacal card configured as 
card number zero. By default, "DEMO-BOARD" is 
installed as card number zero. Right click the card zero 
"DEMO-BOARD" and select either Delete (to remove it 
completely) or Change Board# to reconfigure it at a 
different card number. Then Right click the desired card 
and select Change Board# to reconfigure it as Board zero. 
Your card is now properly configured to operate with 
DynoWare. 
 
The A/D bits, Available channels, Acquisition mode and 
Maximum Channels will be automatically set reflecting the 
card type selected. The gain can be selected in DynoWare 
to your specifications. The gain setting changes the scale 
on the card itself, so the lower the scale means the better 
the resolution. However, it also means a lower overall 
measurement force range, so the user must be careful not 
to choose too high of a gain such that saturation occurs 
(i.e., be sure the forces to be measured do not exceed the 
measuring range of the system. If this occurs, choose a 
lower gain such as ±10 V). 
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4.6 Running DynoWare 

To run DynoWare, open the Kistler Group in the Programs 
extension of the Start Menu and click on the DynoWare 
icon. It is possible to change the program language, see 
section 7.2. 

4.7 Connecting the Measurement Signal Cable ("Analog Input")      

4.7.1 PCIM-DAS1602/16 and PC-Card-DAS16/16 

There is one (1) 37-pin cable that connects the junction 
box or amplifier to the data acquisition card. To properly 
connect the cable: 
 
1. Shut down the computer and turn off the power to the 

computer and the amplifier. 
2. Connect the 37-pin cable from the A/D card to the 

junction box or amplifier.  
3. Be sure to tighten any cable-fastening screws by hand 

to secure the cable connections and prevent slippage 
(do not overtighten). 

4. Turn the amplifier and computer on. 
 
If the cables are not long enough, additional cables could 
be connected to the original ones to extend their lengths. 
Excessively long cables are not recommended because 
insulation may not be adequate to prevent interference 
and loss of signal. 
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4.7.2 Type 5697A DAQ-System for DynoWare 

 

 

DAQ-System, Type 5697A, with DynoWare allows for 
acquisition of up to 28 channels simultaneously, by 
using both "Analog Input" connections. 

 
 
 
 
 
 
 
 
 
 
 

 
 

 
Fig.  6: Connections on DAQ-System Type 5697A 
 
 
A 15-pole low-resistance measurement signal cable Type 
1700A111A2 or type 1700A113A2 connects the 
connecting box of the DAQ-System for DynoWare Type 
5697A to the charge amplifier or signal conditioner. 
Connect the cable as follows: 
 
1. Switch the connecting box and the amplifier or signal 

conditioner off. 
2. Connect the 15-pole cable Type 1700A111A2 from 

the connecting box to the connector box or the 
amplifier. 

3. Tighten the screws on the connector to secure the 
connections (however, to avoid damaging the thread 
do not overtighten). 

4. Switch amplifier and connecting box on. 
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4.8 Connecting RS-232C Interface Cable 

A RS-232C interface cable Type 1200A27 or Type 1475A3 
(see section 9) is required to control the charge amplifier or 
signal conditioner. If the A/D card PCIM-DAS1602/16 or 
PC-Card-DAS16/16 is being used this connection is made 
directly to the PC or notebook, if the DAQ-System Type 
5679A is being employed it is made directly to the 
connecting box. 

4.8.1 Connecting to PC / Notebook 

If there is an RS-232C interface on the PC or notebook, the 
corresponding interface cable (see section 9) is connected 
directly to the notebook. Notebooks in particular often no 
longer have an RS-232C port, and therefore have to be 
used with a USB-RS-232C converter. We recommend also 
purchasing this adapter from Kistler (Type 2867). When 
using such an adapter also ensure the matching software is 
installed. 

4.8.2 Connecting to Connecting Box Type 5697A 

The connection between signal conditioner or charge 
amplifier and DAQ connecting box is also made with an 
RS-232C cable. This is connected directly to the RS-232C 
of Channel 1 on the connecting box. 
 

 

DynoWare is not capable of controlling two charge 
amplifiers or two signal conditioners via DAQ-System 
Type 5697A. Due to that it is not recommended to use 
both RS-232C connectors in parallel. To avoid 
communicating complications, either the RS-232C 
connector of "Unit A" or of "Unit B" should be used to 
connect the amplifier.  
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The used COM-ports of the two serial interfaces of 
DAQ-System Type 5697A can be found in the Device 
Manager of Windows. For the case shown below the 
serial port of Unit A is on COM7, the serial port of Unit 
B on COM8. 

COMx has to be defined in the Hardware settings (see 
chapter 6.2.1) to communicate with charge amplifiers or 
signal conditioners. 
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4.9 Using Remote Control Interface on DAQ-System Type 5697A 

The measuring chain can be triggered via the 'Remote 
Control' interface on the DAQ-System Type 5697. This is 
possible with, for example, the inductive proximity switch 
Type 2233B from Kistler. The pin allocation is to be found 
in section 8, the necessary DynoWare setup in section 
6.2.2.2.  

 

 
 
 
 
 
 

 

4.10 Important Issues Regarding Piezoelectric Dynamometers 

Please take care to follow these rules applying to instal-
lation and handling of dynamometers and connections: 
 Protect the signal conditioner and cable connector ends 

from dust and moisture. Close end caps. 
 Dynamometer mountings must be level and properly 

secured. 
 Use caution connecting and removing the cables. Also 

take care to not step on the cable connections to avoid 
shearing off the cable. 

4.11 Charge Amplifiers 

DynoWare automatically controls the range selection, filter 
selection and operate/reset functions of several types of 
Kistler charge amplifiers. Charge amplifiers should be 
allowed to warm up sufficiently for most accurate measu-
rements, with 30 minutes being a minimum. Unplug the 
amplifier if it is not to be used for a very long time. 
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5. Quick Start 

This section will help familiarize the new user with 
DynoWare.  
 
Data cannot be acquired until the hardware is properly 
configured. This section is meant as an overview to the 
features of DynoWare that will be applied to acquired trials 
and graphs once the proper configurations have been 
performed. For more information on configuring 
DynoWare, refer to section 6.2. 
 

 
Fig.  7: Running DynoWare from the Start menu 

 
Start DynoWare by choosing: 
Start → (All) Programs → Kistler → DynoWare  → 
DynoWare. 
 
The splash screen appears briefly and shows current 
application version and product type information. 

 
Fig.  8: DynoWare "Splash Screen" 

 
The File menu allows you to open stored trials, print, save, 
export, manage configurations and exit the program. The 
print setup can be customized here also. Feel free to open 
some of the supplied trials (by default: 
C:\Kistler\DynoWare\Data) and manipulate them to help 
familiarize you with the program’s capabilities. 
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The Acquisition menu is where hardware is configured and 
where data acquisition is performed. Choosing Acquisition 
→ Hardware will bring up the Hardware Dialog Box (Fig.  
9) showing the configuration settings. Choosing Acqui-
sition → Setup allows the user to configure data acquisition 
specific parameters (Fig. 10). Acquisition → Start will begin 
the acquisition process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.  9: Hardware setup dialog box 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.  10: Edit Acquisition 
 
The View menu allows the user to configure DynoWare 
graphic preferences and to edit the trial documentation. 
Selecting View  Setup (section 6.3.3) allows configura-
tion of the default graphs that appear when a file is 
opened or a trial is acquired. With View  Edit the content 
of an individual graph can be changed.  
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Double clicking on a specific feature of the graph (title, 
legend or axis title) provides editing capability. 
 
The view can be changed at any time without adversely 
affecting the data in any way. A user may also zoom the 
displayed area, enable/disable grid lines, display a moving 
cursor, and edit labels and documentation information 
from the View menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.  11:  View Edit 
 
The Analysis menu gives options for smoothing or filtering 
data, statistic options and data manipulation. 
 
The Tools menu provides two methods for displaying real-
time voltage data: Oscilloscope and Voltmeter. These tools 
are designed for simple troubleshooting of the system. 
 
The other menu that appears when a graph is shown is the 
Window menu. The Window menu uses standard 
Microsoft Windows commands to arrange active windows. 
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6. Reference 

This section describes the menus used in DynoWare. 

6.1 File... 

Depending on whether or not a graph is open on the 
screen, the File menu will have a different appearance. If 
no graph is open, there will only be commands to Open, 
Configuration, Export and Exit DynoWare. 

6.1.1 Open… 

This will bring up a file open  dialog box where the desired 
trial can be selected for viewing. The default directory is 
the data directory, though the dialog box can be easily 
navigated using standard Windows techniques to browse 
other drives, directories, and network computers. The 
extension for the trials are "*.dwd". Files stored in 
DynoWare 1.x format will automatically be converted and 
loaded. 
 
If a valid configuration file exists, the Load Configuration 
File check box will be available and the user can choose to 
load the configuration options associated with the file 
(hardware setup, data acquisition, and view setups). If a 
configuration was not stored for the data file, this option 
will be disabled and appear grayed out.  
 

6.1.2 Save modified file 

The operations Smoothing on (see section 6.4.4), Filtering 
on (see section 6.4.6) and Signal Drift Compensation (see 
section 6.4.3) display temporary changes to a data set. 
These operations do not permanently affect the data 
stored in a file. To permanently archive these changes, 
select Save modified file from the File menu. 
 
This operation allows the user to apply several different 
functions to a data set. For instance, data can be compen-
sated for drift; the changes save in the file, and then Mean 
value analysis can be done. Normally the drift compen-
sation and mean value functions are mutually exclusive 
(cannot be done at the same time). 
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Overwritten changes cannot be undone and perma-
nently modify the data in the file. The original data file 
will be saved as "*.bak.dwd".   

6.1.3 Configuration... 

The Hardware, Data Acquisition and View settings can be 
loaded or stored to a file. The default extension for 
configuration files is "*.cfg".   

6.1.3.1 Load… 

To load the Hardware, Data Acquisition and View settings 
from a configuration file select Configuration Load.  This 
will overwrite the existing DynoWare configuration set-
tings. A standard Windows file open dialog box (see Fig. 
12) will be presented to select the appropriate 
configuration file to load. To load a configuration file 
automatically when a data file is opened enable the Load 
configuration file option in the File Open dialog box (See 
chapter 6.1.1). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.  12: Configuration Load 

6.1.3.2 Save… 

To store the Hardware, Data Acquisition and View settings 
to a configuration file select Configuration Save.  A stand-
ard Windows file save dialog box will be presented to 
select the appropriate configuration file name to save the 
current settings. The default extension of configuration 
files is "*.cfg". Configuration files can be saved auto-
matically by checking the Save configuration option in the 
Acquisition Edit dialog box. 
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6.1.4 Export… 

Files may be exported to ASCII delimited text files by 
selecting File Export (e.g. for further evaluation in 
Microsoft EXCEL). The Export Dialog allows for the 
selection of the cycles to export, and the channels to 
export. All measurements are exported with Every sample. 
The setting Every n-th sample results in only every n-th 
measurement being exported and the intermediate 
measurements being lost.  
The setting Export mean value of group (of n samples) 
results in the mean of n measurements being exported 
rather than individual measurements. Values from 2 to 100 
can be entered for n. 
The option Export partial time interval exports data of a 
defined time frame. 
The original DynoWare file is not changed by such data 
reduction; it is just that fewer data points are exported. 
This simplifies importation of Excel spreadsheets, whose 
row count is limited to 65 000. Fig.  13 makes it possible to 
select which channels and which measuring cycles are to 
be exported. The user can choose the data delimiter or 
enter one of their own. If Comma is chosen as a separator 
the extension of the file is changed to “*.csv” 
automatically.  
 
The destination of the export file can be chosen by 
selecting … in Fig. 13. To export data confirm settings with 
OK. A new box is displayed to show progress. An example 
of an exported file is shown below. 
 
Use the Select All / Unselect All on Fig. 13 buttons to 
select the required channels and measuring cycles faster. 
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Fig.  13: Export dialog box 
 
 

 

Tip: 

Using tabs as delimiters allows the export file to be 
opened directly in Microsoft Excel.  

 
 

 

DynoWare uses the American number format with a 
period "." as decimal separator and comma symbol "," 
for digit grouping. If the country setting for numbers on 
Control Panel is set otherwise problems can arise when 
the export file is opened in Excel, as some numbers will 
be read as date. 
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Example of an exported file: 
 

FILE TYPE:   

Path: C:\DynoWare_Data\IPL-Tagung\  

Filename: 5A-Fraesen_Aussen_2.dwd  

Config ID: 5A-Fraesen_Aussen_2.cfg  

Setup ID: 0  

Manipulated: 0  

Filename 1:    

Filename 2:    

Date: Monday, 12 September , 2000  

Time: 13:43:19  

Sampling rate [Hz]: 3000  

Measuring time [s]: 90  

Delay time [s]: 0  

Cycle time [s]: 0  

Cycles: 1  

Samples per channel: 270001  

Cycle interval: 0  

Channel enabled: 1 1 

Cycle No: 1  

Time [s] Fz Mz 

0 -2.83203 2.44E-03 

3.33E-04 -3.11523 -4.88E-03 

6.66E-04 -3.11523 -2.44E-03 

1.00E-03 -3.11523 -2.44E-03 

1.33E-03 -2.83203 -2.44E-03 

1.67E-03 -2.54883 -2.44E-03 

... ... ... 

2.67E-03 -2.54883 -2.44E-03 

6.1.5 Print...  

Shortcut: Ctrl+P 
 
Print… brings up the Print dialog box (Fig. 14) using the 
default print settings. The user selects the views to be 
printed by clicking on the views in the list. The Document 
title appears as the default graph title but the user can 
change the title here. Pressing the Select All button will 
select all open views to be printed. Print Acquisition and 
Hardware Information enables the printing of the Amplifier 
and Acquisition configuration at the bottom of the 
printout, previewing the printout on screen prior to making 
a hardcopy, and printing to a file for later viewing.  
 
Some printout information will be disabled if the selected 
view contains Multiple cycle data. 

 
Fig.  14: Print dialog 

File Data  
 

File Header Information 
 

File Header Information 
 



 Reference 
 
 

2825A_002-195e-10.13-Korr.Ex.03  Page 35 
 

  
After selecting OK, the Printer selection dialog will appear 
allowing the user to change the printer and select the 
number of copies to print. 
 
If the Preview option was checked the print preview screen 
will appear (see section 6.1.6). 
 

 
Fig.  15: Printer selection 

6.1.6 Print Preview… 

The Print Preview… is identical to the Print function above 
except the output appears on the monitor. This allows the 
user to see what the printout will look like on the prior to 
printing so that any necessary changes can be made before 
the print function is carried out. From this dialog box you 
can zoom in on the image for a closer look, create a print 
file, directly email a print file and execute the hardcopy 
Print function. 
 
A print file is a special "*.ll" file that can be viewed with a 
special viewer. The special viewer, LLViewer, is available on 
the installation CD-ROM in the LLViewer subdirectory or in 
the installation directory – by default C:\Kistler\ 
Dynoware\. Run the LLView.exe installation program and 
follow the onscreen instructions. Files directly emailed will 
need the LLViewer to view the email contents.  
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Fig.  16: Print preview 
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6.1.7 Print Setup… 

Print Setup… allows the user to configure the printing 
specifications. Standard setup functions are to select the 
printer, paper size and tray (if applicable), and the paper 
orientation. A Properties button allows further customizing 
of printer settings. 

6.1.8 Copy to Clipboard 

This will copy the active window contents to the Windows 
clipboard. The graph can then be pasted into a word 
processing or spreadsheet application as a graphic. 

6.1.9 Exit 

Exit closes DynoWare. Since changes to the data are 
continuously stored in the file, no extra question is neces-
sary about saving changes. 

6.2 Acquisition 

The Acquisition menu is where all data acquisition and 
hardware configuration is performed. 

6.2.1 Hardware… 

Shortcut: Alt+H 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  17: Hardware configuration 
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The Hardware… dialog box allows the user to customize 
specific equipment used in the system. The dialog has 
several different tabs dependent upon the specific amplifier 
configured in the system. There are up to four major items 
that can be configured: The A/D card, the amplifier and 
the dynamometer plus force & torque calculation and 
communication interface settings specific to an amplifier. 
 

6.2.1.1 A/D Card 

The A/D card is automatically selected from the INSTACAL 
board configuration program from Measurement 
Computing (see section 4.4). This tab shows the 
configured A/D card (board in Instacal) and allows the user 
to edit the A/D board gain selection (A/D Board Full Scale 
measurement range in volts). 

 
Fig.  18: A/D card setup 

 
Information displayed is: 

Board  Displays the A/D card that is configured in the INSTACAL 
program. 

Full Scale The A/D Board Full Scale input defines the resolution of 
the A/D card: Small Full Scale = more resolution per volt, 
Note: All input voltage signals to the card must be smaller 
than the defined Full Scale. 

Burst Mode Normally, the sampling clock runs at 1/(sample rate * 
number of channels).  This results in some fixed latency in 
sampling time between individual channels.  To minimize 
latency, Burst Mode allows each channel bank to be 
scanned / sampled at the full rate of the card.  

Example:  

Sampling 2 channels @ 50 Hz, max. throughput 100 kHz. 

Non Burst Mode Channel to Channel latency time = 
1/(50*2) = 0,01 s = 10,0 ms 

Burst Mode Channel to Channel latency time =  
1/(100 000) = 0,000001 s = 0,01 ms 
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When burst mode is enabled, the system closely 
approximates Simultaneous Sample and Hold. 
 

 

If the PC-CARD-DAS16/16 is being used, DynoWare 
disables the burst mode for data throughputs greater than 
33 kHz, as this card cannot be operated in the burst mode 
at such high rates. 

 

 
 

If the DAQ-System Type 5697A is being used, DynoWare 
automatically enables the burst mode without any 
necessity for additional settings. 

 
Description Description of the A/D card manufacturer. 
Max. Throughput  Displays maximum throughput of the A/D card. 
Resolution Displays resolution of the A/D card. 
Analog Channels Displays the maximum number of the analog channels 

available. 
Digital Channels Displays the maximum number of the digital channels 

available. 

6.2.1.2 Show Hardware Dialog between Acquisition Cycles 

If enabled, the hardware dialog will appear prior to 
acquiring data for a cycle. The checkbox enables or disab-
les this option. Only changes to the amplifier settings, and 
operate/reset state are allowed after switching to the data 
acquisition mode. Select the Acquisition  Hardware 
option to re-enable this option, or to make extended 
changes to the configuration. 

6.2.1.3 Amplifier Selection 

The user should first choose the amplifier selection from 
the bottom of the dialog, Supported amplifiers are the 
Type 5017/5019, Type 5011/5015, Type 5018,  Signal 
Conditioner Type 5223 to RCD Type 9123… and 9124…, 
Signal Conditioner Type 5237 for HS-RCD Type 9125A…, 
Signal Conditioner Type 5238 and Amplifiers Type 5070 
and 5080. 
 
The entry Others offers a free choice for other amplifiers. 
 
 
 
 
 
 
 
 

 
 
Fig. 19: Amplifier selection 
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6.2.1.4 Configurations using Amplifier Type 5017/5019 

Selecting 5019/5017 in the amplifier selection (see section 
6.2.1.3) will enable the multichannel 5017/5019 tab, the 
RS-232C Setup tab, and the Multicomponent 
Measurement tab.  

6.2.1.4.1 Multichannel Amplifier Type 5017/5019 

The multichannel configuration tab allows for customi-
zation of Type 5017 or 5019 multichannel charge 
amplifier. There are several configurable parameters 
associated with this amplifier: 

Channel Channel number displays the specific channel number 
ranging from 1 up to 8.  

Label Enter any label for each channel. This label will appear on 
graphs and reports. 

Measuring Range Enter the Measuring Range (Maximum measurable 
amount) [M.U.] of each channel (M.U. = Mechanical Unit). 

Unit Enter the display units of each channel. 

Scale The Scale setting for the amplifier is automatically 
determined from the Measuring Range and the full scale 
output capability of the amplifier. Scale [M.U./V] = 
Measuring Range [M.U.] / 10,0 V 

Sensitivity Enter the sensitivity of a sensor (see calibration sheet). 

Filter Select the desired low-pass filter (internal filter in the signal 
conditioner) to be used. 

Time Constant Select the desired Time Constant (internal high-pass filter 
in the signal conditioner) to be used. 

Measure Transmit the command to place the amplifier into the 
measure (operate) mode. 

Reset Transmit the command to switch the amplifier to reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for Sensitivity, Range, Filter, and Time 
constant settings. 

Reset/Operate Enable automatic control (via RS-232C interface) of the 
Operate/Reset commands during a typical acquisition 
cycle. Amplifier will be automatically set to operate at the 
start of a cycle, and will return to reset after the acquisition 
has completed for any given cycle. In some cases, this 
automatic control of Reset/Operate is not desired and the 
selection box should remain unchecked. 

6.2.1.4.2 RS-232C Setup 

The RS-232C configuration must be properly configured 
using the RS-232C Setup Tab for Type 5017 or 5019 to 
function properly. 
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Serial Port Selects the COM port used to control the signal 
conditioner. This is the port on the PC to which the serial 
cable is connected. 

Baud Rate Selects the data transmission rate used to communicate 
with the signal conditioner. This setting must be identical 
to the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Data Bits Selects the number of data bits used in the data 
communication protocol. This setting must be identical to 
the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Stop Bit Selects the number of stop bits in the data transmission 
protocol. This setting must be identical to the setting in the 
signal conditioner. Refer to the signal conditioner manual 
to determine the proper setting. 

Parity Selects the parity checking used during communication 
with the signal conditioner. This setting must be identical 
to the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Handshaking Selects the handshaking method used during communica-
tion with the signal conditioner. This setting must be 
identical to the setting in the signal conditioner. Refer to 
the signal conditioner manual to determine the proper 
setting. 

 

 

Typically the communication is configured for COM x,  
9 600 baud, 8 data bits, 1 stop bit, no parity, and no 
handshaking. 

See chapter 4.8 to figure out what COM-port is 
currently used. 

6.2.1.4.3 Force & Torque Calculation  

With the multichannel Amplifier Type 5017 and the 
appropriate hardware, additional software calculations can 
be performed. These calculations can provide resultant 
forces and torques for various types of dynamometers, in a 
variety of applications. If a multichannel calculation is 
enabled, the user can no longer enable/disable channels in 
the configuration (Section 6.2.2.2). Select the 
Multicomponent Mode calculation type from the list 
presented corresponding to your specific hardware 
dynamometer. 
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6.2.1.4.3.1 Mode Off 

Force & Moment calculations are disabled. 

6.2.1.4.3.2 Type 1 

The type 1 dynamometer measures 4 shear components 
and 1 vertical component. From the raw components Fx, 
Fy, Fz and Mz are calculated. The user must configure the 
a1, a2, b1, and b2 distances. 
 
 
 
 
 
 
 
 
 
 

6.2.1.4.3.3 Type 1a 

The type 1a dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mz are calculated. The user must configure the 
a1, a2, b1, and b2 distances. 
 
 
 
 
 
 
 
 

 
 

6.2.1.4.3.4 Type 2 

The type 2 dynamometer measures 2 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My are calculated. The user must configure 
the distances a and b. 
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6.2.1.4.3.5 Type 3 

The type 3 dynamometer measures 4 shear components 
and 2 vertical components. From the raw components Fx, 
Fy, Fz and Mx, Mz are calculated. The user must configure 
the distances a and b. 
 
The type 3 dynamometer is for Type 9265C... only. 
 
 
 
 
 
 
 
 

6.2.1.4.3.6 Type 4 

The type 4 dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the distances a and b. 
 
 
 
 
 
 
 
 
 
 

6.2.1.4.3.7 Type 5 

The type 5 dynamometer measures 5 shear components 
and 3 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the distances a, b and c. 
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Sensor Distances Enter the distances between sensors from the drawing 
given for the appropriate dynamometer type. All distances 
are entered in millimeters [mm]. 

Dynamometer Top View This window shows a drawing defining the coordinate 
system, and sensor layout for the selected dynamometer. 
Use this as a guide when entering sensor distances, 
configuring your system and interpreting data. 

Output Window The output window shows channel allocation for acquired 
and calculated channels. This should be used as a guide 
when configuring graphs. 

6.2.1.5 Configurations using Type 5011/5015 amplifiers 

Selecting Type 5011/5015 in the amplifier selection (see 
section 6.2.1.3) will enable the Charge Amplifier Type 
5011/5015 tab. 

6.2.1.5.1 Charge Amplifier Type 5011/5015 

The following parameters should be set when using 
5011/5015 charge amplifiers in DynoWare: 
 

Communications Selection The user can select the remote control mode, either via  
RS-232C (in which case only channel 1 can be remotely 
controlled) or via IEEE-488  (in which case all channels can 
be remotely controlled). If RS-232C is chosen, a RS-232C 
Setup tab will appear to allow custom configuration of the 
communication parameters. If IEEE-488 is chosen, an IEEE-
488 (GPIB) Setup tab will appear to allow selection of the 
communication library. 

Channel Channel number. Channels range from 1 to 8.  

Label Enter any label for each channel. This label will appear on 
graphs and reports. 

Measuring Range Enter the Measuring Range [M.U.] of each channel (M.U. 
= Mechanical Unit). 

Unit Enter the display units of each channel. 

Scale The Scale setting for the amplifier is automatically 
determined from the Measuring Range and the full scale 
output capability of the amplifier. Scale [M.U./V] = 
Measuring Range [M.U.] / 10,0 [V] Output; (M.U. = 
Mechanical Unit) 

Sensitivity Enter the sensitivity of a sensor (see calibration sheet). 

Filter Select the desired low-pass filter (internal signal filter in the 
signal conditioner) to be used. 

Time Constant  Select the desired high-pass filter Time Constant (internal 
signal filter in the signal conditioner) to be used. 
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IEEE Address Enter the IEEE-488 address of the selected Type 
5011/5015. The selected channel address must match the 
address configured in the 5011/5015. Please refer to Type 
5011/5015 user manual for information on configuring the 
IEEE-488 address. Each device must have a unique address. 
This applies only if IEEE communication mode is selected. 

Measure Transmit the command to place the amplifier into the 
measure (operate) mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameter Transmit the command to set the appropriate per channel 
configuration for Sensitivity, Range, Filter, and Time 
constant settings. 

Reset/Operate Enable the automatic control (via RS-232C or IEEE-488 
interface) of the Operate/Reset commands during a typical 
acquisition cycle. Amplifier will be automatically set to 
operate at the start of a cycle, and will return to reset after 
the acquisition has completed for any given cycle. In some 
cases, this automatic control of Reset/Operate is not 
desired and the selection box should remain unchecked.  

6.2.1.5.2 RS-232C Setup  

(See section 4.8 or 6.2.1.4.2) – This tab will only appear if  
RS-232C interface is selected. 

6.2.1.6 Setup for Charge Amplifier Type 5018 

If Type 5018 is chosen (see section 6.2.1.3), the 
parameters for charge amplifier Type 5018 are applied. 

6.2.1.6.1 Charge Amplifier Type 5018 

The following parameters must be set if charge amplifier 
Type 5018 is being used: 
 

Channel Displays the specific channel number ranging from 1 to 8.  

Label Enter any label for each channel. This label will appear on 
graphs and reports. 

Measuring Range Enter the Measuring Range (maximum measurable 
amount) [M.U.] for each channel (M.U. = mechanical 
unit). 

Unit Enter the mechanical display units of each channel. 

Scale The Scale setting for the amplifier is automatically 
determined from the Measuring Range and the full scale 
output capability of the amplifier: Scale [M.U./V] = 
Measuring Range [M.U.] / 10,0 [V] Output. 
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Sensitivity Enter the sensitivity of the sensor (see calibration sheet) 

 

 

Filter Select the required low-pass filter (internal filter in the 
charge amplifier). 

Time constant Select the required Time Constant of the high-pass filter 
(internal hardware filter in the charge amplifier). 

COMx Enter the COM port of the required Type 5018. Each 
device must have its own address. On the selected 
connector the serial (RS-232C or USB) cable must be 
connected to the charge amplifier. 

Measure Transmit the command to switch the amplifier into the 
measure (operate) mode. 

Reset Transmit the command to switch the amplifier into the 
Reset mode. 

Send parameters Transmit the settings for Sensitivity, Range, Filter and Time 
Constant for each channel to the charge amplifier. 

Reset/Operate Enable automatic control (via RS-232C or USB interface) of 
the Operate/Reset commands during a measuring cycle. 
The amplifier will be automatically set to operate at the 
start of a cycle, and to reset after any given cycle has been 
acquired. This automatic control option must be disabled in 
those particular cases in which it is not required. 

6.2.1.6.2 RS-232C Setup 

See section 4.8 or 6.2.1.4.2 

6.2.1.6.3 USB Setup 

The charge amplifier Type 5018 can also be controlled via 
USB instead of RS-232C. The following settings must be 
made: 
 Connect the Type 5018 to the PC with the included 

USB cable. 
 Install the drivers (from the CD included with the Type 

5018) if this has not already been done. 
 Choose COMx port. The chosen COM port must be 

the same as that to which the charge amplifier is 
connected. Please take a look at the Windows device 
manager (see chapter 6.2.1.4.2) .  

6.2.1.7 Configurations Using Other Amplifiers 

Selecting Others in the amplifier selection (see section 
6.2.1.3) will enable the Other tab. 
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6.2.1.7.1 Others 

The other adapter tab allows for generic amplifier 
configuration. In this setup no specific equipment is cont-
rolled. The data provided allows DynoWare to convert data 
from measured voltages to real mechanical units. The 
information configured in this tab is: 

Channel Channel number used for configured devices and con-
nections. 

 

Connector Unit according to the channel 

Label Enter any label for each channel. Labels will appear on 
graphs and reports. 

Measuring Range Enter the measuring Range of each channel (if not 
activated, use double click or F4). You can either enter an 
overall measuring range, or an individual range and 
sensitivity. Measuring Range [M.U.] = Sensor Range [pC] 
divided by Sensitivity [pC/M.U.] (M.U. = Mechanical Unit). 

Unit Enter the unit of each channel. The configured units will 
appear on graphs and reports 

FS Enter the full scale (FS) of each channel. 

Range 1 Enter the range of the adapter for each channel (activate 
with double click or F4). 

Sensitivity Enter the sensitivity of a sensor (activate with double click 
or F4). 

6.2.1.8 Configurations Using Rotating Cutting Dynamometer Type 9123/9124  
with Signal Conditioner Type 5223 

Selecting RCD Type 9123/9124 with Signal Conditioner 
Type 5223 in the amplifier selection (see section 6.2.1.3) 
will enable the RCD 5223 tab, the RS-232C Setup tab, and 
the RCD Calculations tab. 

6.2.1.8.1  RCD 5223 

The rotating cutting dynamometer requires the configu-
ration of the following parameters: 

Channel Channel number. Channels range from 1 to 6.  

Label Assign labels for each channel. These labels appear in 
graphs and reports. 

Measuring Range The measuring range is automatically assigned based on 
the Scale and Sensitivity settings. Measuring Range [M.U.] 
= Full Scale Output [mV] divided by Sensitivity [mV/M.U.]; 
(M.U. = Mechanical Unit). 

Unit Assign units to each channel. These labels appear in graphs 
and reports. 
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Full Scale Output (FSO) Assign the full scale setting for the amplifier in [mV]. 

Sensitivity Enter the sensitivity of a sensor in [mV/M.U]. Two 
sensitivities (coarse / fine range) for forces Fx, Fy and Fz are 
specified on the calibration sheet. Even four sensitivities are 
specified for the torque Mz. 

Range Selection Select the desired measurement range. Range I is a coarse 
range, Range II is a fine range. 

Zoom Channel Select the channel to appear as the zoom output channel. 
You can select Fx, Fz or Mz. The output signal of channel 5 
(zoomed channel → see manual of rotating Dynamometer) 
of the signal conditioner amplifies the signal by factor 10. 
The same sensitivity has to be entered for both original 
channel and zoomed channel to amplify by factor 10. 

Measure Transmit the command to place the amplifier into the 
measure (operate) mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for Sensitivity and Range settings, and the 
zoom channel selection. 

Reset/Operate Enable the automatic control (via RS-232C interface) of the 
Operate/Reset commands during a typical acquisition 
cycle. Amplifier will be automatically set to operate at the 
start of a cycle, and will return to reset after the acquisition 
has completed for any given cycle. In some cases, this 
automatic control of Reset/Operate is not desired and the 
selection box should remain unchecked.  

6.2.1.8.2 RS-232C Setup  

(see section 4.8 or 6.2.1.4.2) 

6.2.1.8.3 RCD Calculations 

With Type 5223... additional software calculations can be 
performed. These calculations can provide radial and 
tangential forces or active force in a variety of applications. 
If a RCD calculation is enabled, the user can no longer en-
able/disable channels in the Channels configuration (see 
section 6.2.2.2). 

6.2.1.8.3.1 Off 

RCD Calculations are disabled  
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6.2.1.8.3.2 Type 1 

The type 1 RCD Calculation computes the active force Fa. 
The tool diameter D does not have to be entered for this 
calculation. 
 
 
 
 
 
 
 
 
 
 

6.2.1.8.3.3 Type 2 

The type 2 RCD Calculation computes the Fr (Radial Force) 
and Ft (tangential force) cutting force parameters. The user 
must configure tool diameter D. 
 
 
 
 
 
 
 
 
 
 
 

 

Tool Diameter Enter the tool diameter for the appropriate tool under test. 
All distances are entered in millimeters "mm". 

Tool View This window shows a drawing defining the coordinate 
system, and tool measurement layout for the selected 
dynamometer.  

Output Window The output window shows channel allocation for acquired 
and calculated channels. This should be used as a guide 
when configuring graphs.  
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6.2.1.9 Configurations Using Rotating Cutting Dynamometer Type 9125  
with Signal Conditioner Type 5237  

Selecting RCD Type 9125 with Signal Conditioner Type 
5237 in the amplifier selection (see section 6.2.1.3) will 
enable RCD Type 5237 tab, and the RS-232C Setup tab. 

6.2.1.9.1  RCD Type 5237 

To configure Type 5237 high speed rotating cutting 
dynamometer, configure the following:  

Channel Channel number. Channels range from 1 to 2.  

Label Assign labels for each channel. These labels appear in 
graphs and reports. 

Measuring Range The measuring range is automatically assigned based on 
the Scale and Sensitivity settings. Measuring Range [M.U.] 
= Full Scale Output [mV] divided by Sensitivity [mV/M.U.]; 
(M.U. = Mechanical Unit) 

Unit Assign units to each channel. These labels appear in graphs 
and reports. 

Sensitivities Range I, Range II and Range III – enter the sensitivity of a 
sensor in [mV/M.U.] for each of the calibrated ranges (see 
calibration sheet). 

Range Selection Select the desired measurement range from the pull-down 
choice box. Range I is a coarse range, range III is a fine 
range. 

Measure Transmit the command to place the amplifier into the 
measure (operate) mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for the Range settings. 

Operate/Reset  Enable the automatic control (via RS-232C interface) of the 
Operate/Reset commands during a typical acquisition 
cycle. Amplifier will be automatically set to operate at the 
start of a cycle, and will return to reset after the acquisition 
has completed for any given cycle. In some cases, this 
automatic control of Reset/Operate is not desired and the 
selection box should remain unchecked.  

6.2.1.9.2 RS-232C Setup 

(see section 4.8 or 6.2.1.4.2) 
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6.2.1.10 Configurations using Multichannel Amplifier Type 5070  

Selecting Type 5070 in the amplifier selection (see section 
6.2.1.3) will enable the Multichannel Amplifier Type 5070 
tab, the RS-232C Setup tab, and the Force & Moment 
Calculation tab.  
 

6.2.1.10.1 Multichannel Amplifier Type 5070 

The Multichannel configuration tab allows for customi-
zation of Type 5070 Multichannel Amplifier. There are 
several configurable parameters associated with this 
amplifier: 

5070 version Selects Type 5070 version, 4-channel, 8-channel or 8-
channel summation. The version affects the behavior of the 
remaining options. 

Channel Channel number displays the specific channel number 
ranging from 1 to 8 (channels 1 to 4 for 4-channel type).  

Label Enter any label for each channel. This label will appear on 
graphs and reports. 

Sensitivity Enter the sensitivity of a sensor (see calibration sheet). 

Unit (Sensitivity) Enter the sensitivity units of a sensor (see calibration sheet).  

Measuring Range Enter the Measuring Range (Maximum measurable 
amount) of each channel. 

Unit (Measuring Range) Enter the Measuring Range Unit/Display Unit of each 
channel. 

Filter Select the desired low-pass filter (internal filter in the signal 
conditioner) to be used. 

Time Constant Select the desired Time Constant (internal high-pass filter 
in the signal conditioner) to be used. 

Measure Transmit the command to switch the amplifier into the 
measure mode (operate mode). 

Reset Transmit the command to switch the amplifier into reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for Sensitivity, Range, Filter, and Time 
constant settings. 

Measure Mode Set to On Start Acquisition for automatic control (via  
RS-232C interface) of the measure mode (Operate/Reset) 
during a typical acquisition cycle. Amplifier will be automa-
tically set to operate at the start of a cycle, and will return 
to reset after the acquisition has completed for any given 
cycle. In some cases, this automatic control of 
Reset/Operate is not desired and the selection box should 
be set to Manual (5070). 

Sensor Distances (Available for Type 5070 8 Channel Summing only) Enter 
the dynamometer dimensions 'a' and 'b' in mm. See 
section 6.2.1.10.3 for more information. 
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Correction Factors (Available for Type 5070 8 Channel Summing only) Enter 
the dynamometer moment correction factors kMx, kMy and 
kMz from the dynamometer calibration sheet. These 
correction factors are specified only if the dynamometer 
was calibrated with a custom calibration. 

6.2.1.10.2 RS-232C Setup 

The RS-232C configuration must be properly configured 
using the RS-232C Setup Tab for Type 5070 to function 
properly. 

Serial Port Selects the COM port used to control the signal 
conditioner. This is the port on the PC to which the serial 
cable is connected (see section 4.8). 

Baud Rate Selects the data transmission rate used to communicate 
with the signal conditioner. This setting must be identical 
to the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Data Bits Fixed at 8 data bits for Type 5070 amplifier. 

Stop Bit Fixed at 1 stop bit for Type 5070 amplifier. 

Parity Fixed at OFF data bits for Type 5070 amplifier. 

Handshaking Fixed at None for Type 5070 amplifier. 

6.2.1.10.3 Force & Moment Calculation 

With the Type 5070 version set to 8-channel and the 
appropriate equipment, additional software calculations 
can be performed. These calculations can provide resultant 
forces and torques for various types of dynamometers, in a 
variety of applications. If a multichannel calculation is 
enabled, the user can no longer enable/disable channels in 
the configuration (Section 6.2.2.2). Select the 
Multicomponent Mode calculation type from the list 
presented corresponding to your specific hardware 
dynamometer. 
 
The 8-channel version of the charge amplifier Type 5070 
with hardware summation calculates the resultant forces 
and torques in real time. However, only the type 4 
dynamometer is supported in this case (see section 
6.2.1.10.3.6). 

6.2.1.10.3.1 Mode Off 

Force and Moment calculation disabled. 
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6.2.1.10.3.2 Type 1 

Option not allowed with Type 5070 amplifier. 
 

6.2.1.10.3.3 Type 1a 

The type 1a dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mz are calculated. The user must configure the 
distances a1, a2, b1, and b2. 
 
This is only available for Type 5070 8-channel. 
 
 
 
 
 
 
 
 
 
 

6.2.1.10.3.4 Type 2 

Option not allowed with Type 5070 amplifier. 
 

6.2.1.10.3.5 Type 3 

The type 3 dynamometer measures 4 shear components 
and 2 vertical components. From the raw components Fx, 
Fy, Fz and Mx, Mz are calculated. The user must configure 
the distances a and b. 
 
The type 3 dynamometer is for the dynamometer 
'MiniDyn' Type 9256... only. 
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6.2.1.10.3.6 Type 4 

The type 4 dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must confi-
gure the distances a and b. 
 
This option is available for 8-channel and 8-channel 
summing. 
 
 
 
 
 
 
 
 

6.2.1.10.3.7 Type 5 

The type 5 dynamometer measures 5 shear components 
and 3 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the distances a, b and c. 
 
This is only available for 8-channel. 
 
 
 
 
 
 
 
 
 
 

Sensor Distances Enter the distances between sensors from the drawing or 
the data sheet of amplifier Type 5070 given for the 
appropriate dynamometer type. All distances are entered in 
millimeters [mm]. 

Dynamometer View This window shows a drawing defining the coordinate 
system, and sensor layout for the selected dynamometer. 
Use this as a guide when entering sensor distances, 
configuring your system, and interpreting data. 

Output Window The output window shows channel allocation for acquired 
and calculated channels. This should be used as a guide 
when configuring graphs. 
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6.2.1.11 Setup for Multichannel Charge Amplifier Type 5080 

If the Type 5080 is chosen (see section 6.2.1.3), the 
parameters for this multichannel amplifier are applied, with 
other tabs for the serial interface and multicomponent 
measurement. 

6.2.1.11.1 Multichannel Amplifier Type 5080 

The multichannel setup tab allows the user-defined settings 
for the charge amplifier Type 5080. The following 
parameters can be set: 

5080 Version Chooses the version or mode of the change amplifier Type 
5080, 1-channel, 2-channel, … 8-channel and 8-channel 
summing (with hardware summation).  

Channel Channel number displays the specific channel number from 
1 to 8.  

Label Enter any label for each channel. This label will appear on 
graphs and reports 

Mode The software identifies different modules (Type 5067) used 
in the amplifier Type 5080. The mode can only be changed 
if a Dual-Mode module (Charge, Voltage, Piezotron) is 
used. 

Sensitivity Enter the sensitivity of the sensor (see calibration sheet) 

Unit (Sensitivity) Enter the unit for the sensor sensitivity (see calibration 
sheet). 

Measuring Range Enter the Measuring Range (maximum measurable 
amount) [M.U.] of each channel (M.U. = mechanical unit). 

Unit (Measuring Range) Enter the unit for the Measuring Range. 

Current If a Dual-Mode module is set to Piezotron the output 
current has to be defined. The current ranges from 
1 … 15 mA. 

Filter Choose the required low-pass filter (internal filter in the 
charge amplifier). 

Time Constant Choose the required Time Constant of the high-pass filter 
(internal hardware filter in the charge amplifier). 

Measure Transmit the command to switch the amplifier into the 
Measure (Operate) mode. 

Reset Transmit the command to reset the amplifier into the 
Measure mode.  

Send Parameters Transmit the settings for Sensitivity, Range, Filter and Time 
Constant for each channel to the charge amplifier. 
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Measure Mode Enable automatic control (via RS-232C interface) of the 
Measure/Reset commands during a measuring cycle. The 
amplifier is automatically set to Measure at the start of a 
cycle, and returned to reset after any given cycle has been 
acquired. This automatic control option must be disabled in 
those cases in which it is not required. 

 

Sensor Distances (Available for Type 5080 8-channel Summing only) Enter 
the dynamometer dimensions 'a' and 'b' in [mm] in the 
appropriate fields. 

Correction Factors (Available for Type 5080 8-channel Summing only) Enter 
the dynamometer torque correction factors 'kMx', 'kMy' 
and 'kMz' from the dynamometer calibration sheet. These 
correction factors are specified only if the dynamometer 
was calibrated with a special calibration. 

6.2.1.11.2 RS-232C Setup 

The RS-232C interface must be carefully configured using 
the RS-232C Setup tab for Type 5080 to operate properly. 

Serial Port Selects the COM port. The serial cable to the charge 
amplifier must be connected to the chosen connector (see 
section 4.8). 

Baud Rate Set the data transmission rate used to communicate with 
the charge amplifier. This setting must be identical to that 
of the charge amplifier. Refer to the charge amplifier 
manual to determine the correct setting. 

Data Bits Fixed at 8 data bits for Type 5080 amplifier. 

Stop Bit Fixed at 1 data bit for Type 5080 amplifier. 

Parity Fixed at None for Type 5080 amplifier. 

Handshaking Fixed at None for Type 5080 amplifier. 

 

6.2.1.11.3 USB Setup 

The charge amplifier Type 5080 can also be controlled via 
USB instead of RS-232C, but only if the DAQ-System Type 
5697 is not being used. The following settings must be 
made: 
 Connect the Type 5080 with the included USB cable to 

the PC 
 Install the drivers (from the CD included with the Type 

5080) if this has not already been done 
 Choose serial (COM) port. This must be the same as 

the COM port to which the charge amplifier is 
connected. Please take a look at the Windows device 
manager 
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6.2.1.11.4 Force & Torque Calculation  

With at least the 6-channel version of the charge amplifier 
Type 5080 and suitable dynamometers, resultant forces 
and torques can be calculated for different types of 
dynamometer in a variety of applications. If multichannel 
calculation is enabled, the user can no longer 
enable/disable individual channels in the configuration 
(section 6.2.2.2). Choose the required Multicomponent 
Mode from displayed list corresponding to your 
dynamometer and the application. 
 
The 8-channel version of the charge amplifier Type 5080 
with hardware summation calculates the resultant forces 
and torques in real time. However, only the type 4 
dynamometer is supported in this case (see section 
6.2.1.11.4.6). 

6.2.1.11.4.1 Off Mode 

Multicomponent measurements disabled. 

6.2.1.11.4.2 Type 1 

This type is not supported by the Type 5080 charge 
amplifier.  
 

6.2.1.11.4.3 Type 1a 

The type 1a dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mz are calculated. The user must configure the 
distances a1, a2, b1 and b2.  
 
This is only available in the 8-channel mode. 
 
 
 
 
 
 

6.2.1.11.4.4 Type 2 

This type is not supported by the Type 5080 charge 
amplifier.  
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6.2.1.11.4.5  Type 3 

The type 3 dynamometer measures 4 shear components 
and 2 vertical components. From the raw components Fx, 
Fy, Fz, Mx and Mz are calculated. The user must configure 
the a and b distances. This type is only used when the 
'MiniDyn' Type 9256… dynamometer is being employed. 
 
 
 
 
 
 
 
 
 

6.2.1.11.4.6 Type 4 

The type 4 dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the distances a and b. 
 
This option is available in the 8-channel and 8-channel 
summing mode. 
 
 
 
 
 
 
 

 

6.2.1.11.4.7 Type 5 

The type 5 dynamometer measures 5 shear components 
and 3 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the distances a, b and c. 
 
This option is only available in the 8-channel mode. 
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Sensor Distances Enter the distances between sensors from the drawings or 
the amplifier Type 5080 data sheet for the type of 
dynamometer being used. All distances are in millimeters 
[mm].  

Dynamometer View This window shows a diagram defining the coordinate 
system and sensor layout for the chosen dynamometer. 
Use this as a guide when entering sensor distances, 
configuring your system and interpreting data. 

Output Window The output window shows channel allocation for acquired 
and calculated channels. This should be used as a guide 
when configuring graphs. 

6.2.2 Edit…  

Shortcut: Alt+E 
 
Selecting Acquisition → Edit allows configuration of the 
data acquisition process for DynoWare. The Parameters 
tab provides configuration of the basic sampling and 
storage criteria. The Channels tab provides selection of the 
trigger method and the channels available. The Data 
Manipulation tab allows for user customized data 
calculations to be performed on acquired data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  20: Edit acquisition parameters 
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6.2.2.1 Parameter 

The Parameters tab allows for configuration of the 
following: 

Measuring Time Definition of the actual duration of acquisition measured in 
seconds. 

Sample Rate The Sample rate defines the number of measurements per 
second and per channel. 

 

 

The higher the sample rate, the better is the resolution of 
the measuring signal. 

 

 

 

Because of the huge amount of data a high sample rate is 
automatically equivalent to slow data processing and 
graphics rendering. For detailed analysis, however, 
2 000 Hz or higher might be necessary. 

 

 

High sampling rates and long acquisition duration can 
create large files. Ensure that there is enough disk space 
available when using continuous monitoring. 

 

Cycles This defines the number of measuring cycles (machine 
cycles) to be acquired.  

Continuous If checked the number of cycles is unknown. The acqui-
sition has to be stopped manually.  

Trigger Delay Time The delay time between the trigger signal and measure-
ment start. This can effect the results of data collection if 
used with the pretrigger functionality.  

Save DynoWare file Enable saving the acquisition data into a file. 

Display data Enable displaying acquired data on the screen. 

Export after each cycle If enabled, a separate text file can be automatically 
exported after each data cycle. The Configure button 
allows for configuration of the contents of the exported 
file.  

Show realtime updates If Show realtime updates during acquisition is enabled the 
graph will be periodically updated during the acquisition 
process. In some cases (such as very high acquisition rate 
and high channel counts) enabling realtime updates may 
result in errors during the data acquisition process and 
should be disabled.  
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Information Displays information about the number of Channels used 
for measurement, the number of Samples/Channel, and 
the approximate memory storage size needed for one 
cycle. This depends on the number of channels, the 
sampling time, and the sampling rate. 

File The name of the file. The file extension is '*.dwd' . 

Browse… Browse enables visual selection of a directory (folder) and a 
file name, use the Browse function to find and overwrite an 
existing file or to browse for a folder. 

Directory Displays the selected directory or folder on a disk where 
the file will be stored. 

Save configuration Enable the check to save the configuration when starting 
measurement. DynoWare uses the same file name as for 
the data file, but with the extension '*.cfg' for 
configuration files. See Section 6.1.3.2 Configuration 
Save… for more information about configurations. 

6.2.2.2 Channels 

The Channels tab is configured with the following options 
in the table and trigger sections: 
 

Channel Displays the number of the channel. 
 
On (Enable) Activates/Deactivates a channel if Multicomponent Mea-

surement mode is not activated. 

Trigger Activate a channel as a 'trigger channel' in case of analog 
trigger mode. 

Label Enter any label for the channel (e.g. drilling moment). 

Trigger: On a key  Measurement is started by pressing the Enter key. 

Trigger: Digital (Types 5070, 5080, 5238 – NPN)  
Measurement is started by a pulse at the digital input of 
the charge amplifier Type 5070 or Type 5080 or signal 
conditioner Type 5238 (e.g. with inductive proximity 
switch Type 2233B). 

Trigger: DAQ Measurement is started by an external trigger signal into 
the data acquisition card (e.g. start machine). This signal 
can be fed into either the relevant input for cable Types 
1500A7 or 1500B15 or the connecting box of the DAQ-
System Type 5697A. 

Trigger: Analog Measurement is started if the defined channel has reached 
a certain level. 

Rising / Falling Start of the Trigger at rising or falling edge. 

% / Absolute The analog trigger threshold is defined as a percentage or 
an absolute value. 
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Threshold Specifies in M.U. (mechanical units) or volts the analog 
trigger threshold.  

 

Pretrigger When enabled, the resultant trial will contain the specified 
pretrigger percentage of data prior to the trigger condition. 
If the trial is 10 seconds long and 50 % pretrigger is 
specified, the resulting trial will contain 5 seconds of data 
prior to the trigger and 5 seconds of data after the trigger. 
This is achieved by filling a pretrigger buffer, then 
continuously waiting for the trigger signal. Pretrigger can 
range from 1 …  99 %. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig.  21: Edit acquisition channels & trigger 

6.2.2.3 Data Manipulation 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig.  22: Edit acquisition, data manipulation online 
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Data for any specified channel can be modified with 
standard mathematical functions immediately after the 
data is acquired. The source channels and operation to be 
performed must be specified as well as the destination of 
the calculation.  
 

 

The destination channel data is permanently destroyed. 
Use the data manipulation functions with extreme 
caution. 

 

On (Enable)  Activate the function for the data manipulation. 

1. Base First channel for the data manipulation. 

2. Base Second channel for the data manipulation. Here you may 
also enter constant values. Note: Confirm numerical entries 
with RETURN. 

Operation The mathematical operation to be performed. The 
following functions are available: Addition, Subtraction, 
Multiplication, Division, loga, lnb, exp(e)c, exp(10)d, sqre, 
sqrtf. 

Result Channel to place the result. 

Add Add a new function. 

Remove Remove the selected function. 
 

6.2.3 Start... 

Shortcut: Alt+S 
 
To begin the data acquisition process, select the 
Acquisition → Start menu choice. If the specified storage 
file already exists (as specified in section 6.2.2.1 Acquisition 
Parameter) a prompt will appear to overwrite the existing 
file.  
 

 

If you choose to overwrite the file, all existing data in 
the file will be lost. 

 
 
                                                      
a base 10 logarithm 
b natural logarithm 
c natural exponential 
d base 10 exponential 
e square 
f  square root 
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Fig.  23: Overwrite file prompt 
 
First, if enabled, the Documentation dialog (see Section 
6.3.4.1) will appear. Here notes about the given cycle can 
be added or changed to document the trial cycle. 
 
Next, if Show Hardware dialog between Acquisition 
Cycles is enabled (see Section 6.2.1.2 Show Hardware 
Dialog between Acquisition Cycles), the Hardware con-
figuration dialog will appear allowing changes to the 
amplifier configuration. 
 
Finally, the main data acquisition dialog box will appear 
showing the current cycle number. If analog or digital 
triggering is required, the system will go into the wait for 
trigger state. If Key triggering is enabled pressing the Go 
button or the Enter key will start acquisition. Once a trigger 
has occurred, or Go has been selected, the progress bar will 
update to indicate acquisition status. 
 
To abort acquisition (or stop a continuous cycle acqui-
sition), press the Stop button. Acquired data is saved.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  24: Begin acquisition prompt 
 

 
 

The data acquisition process may take several seconds to 
abort before the next acquisition interval can begin. 
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6.3 View...  

The View menu provides for complete control of the 
graphical output of DynoWare. Graph types and data con-
tent can be selected for individual views and for configura-
tion of a default view set. 

6.3.1 New… 

With a specific window open, selecting New… will create a 
new duplicate window with the identical configuration as 
the current active window. This new view can now be 
configured individually. 

6.3.2 Edit…  

Shortcut: Alt+V 
 
The View Edit configuration provides for control of the 
current windows graph type and contained items. The user 
can also customize the colors of a specific graph item from 
this dialog box, and set view dependence (link to other 
open views of this file).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  25: View Edit 
 
Selected Cycles and Channels are check marked. Click on 
an item to highlight or select it. Click on a highlighted item 
to unselect it. There are three types of graphics: y(t), y(x), 
and numerical. In order to select or change the x-axis in a 
y(x) graph, click on the y-x icon.  
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The following describes additional items in the View Edit 
dialog: 

File Displays the name of the file. 

On (Enable)  Activate a channel. 

Cycle Selects the cycles to be displayed in the view. If two and 
more cycles are selected, they will be superimposed (see 
section 6.3.2.1) 

Channel Select the channels to be displayed. 

Color Shows the color selection for each channel. Color can be 
changed. 

vs. Y2 Selecting vs. Y2 allows graphing vs. two vertical axis scales. 
One scaling will appear on the left of the graph, the 
second scale will appear on the right of the graph. The 
legend will indicate the corresponding axis that applies to 
each line. vs. Y2 applies to time based graphs y(t) only. 

Select all/Unselect all Selects/Unselects all cycles or channels to view. 

View dependence Links two or more windows. Changing in one window 
from one cycle to the next will update the other windows 
accordingly. 

6.3.2.1 Superimposition of views 

It is possible to superimpose signals if two or more cycles 
are acquired in one file. All cycles that have to be 
superimposed have to be activated in the View Edit dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Fig.  26:  Superimposition of views 
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6.3.2.2 Type of View 

Several views are available to display the data. 

6.3.2.2.1 y-t Graph 

Time based graphs display a data vs. the original acquired 
time base for one specific cycle, or for multiple cycles 
(superimposed). 

6.3.2.2.2 y-x Graph 

Y vs. x based graphs display one channel of data vs. 
another channel of acquired data for one specific cycle, or 
for multiple cycles (superimposed).  

6.3.2.2.3 Numerical Graph 

Numerical graphs display a tabular list of time based 
acquired data for one specific cycle. 

6.3.2.2.4 View of FTT Based Graphs 

FFT based graphs display data vs. the frequency base for 
one specific cycle, or for multiple cycles (superimposed). 
The FFT analysis is used to find the frequency components 
of a signal. The scaling of both frequency and amplitude 
axis are linear. 

6.3.2.2.5 Polar Based Graphs 

Polar based graphs display a Mz data vs. Fx, Fy data as a 
scatter graph for one specific cycle, or for multiple cycles 
(superimposed). The acquired data set must contain an Fx 
and Fy channel used to determine the polar coordinate 
angle, and an Mz channel used as the polar coordinate 
radius. If the data set does not contain the appropriate 
channels the Polar graph button will be disabled. The view 
is only informative if a rotating 4-component dynamo-
meter is used. 
 
The polar plot is used to show the relation of the acting 
forces and the actual cutting edge in operation. Thus, the 
load distribution on the single cutting edge becomes 
visible. 
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Fig.  27:  Shows the polar-graph of a measurement with 
a 4-tooth milling cutter 

 
The polar coordinates are calculated from the measure-
ment parameters Fx, Fy and Mz. 
 

 
 

6.3.3 Setup… 

 
 
 
 
 
 
 
 
 
 
 
 
Fig.  28: View Setup 
 
With View → Setup you can configure the windows and 
default graphs that will appear when a file is opened or 
when data is acquired. A user can configure several default 
windows by repeatedly pressing the Add button and 
following the onscreen wizard for creating a new view 
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window. To remove an existing view, highlight the view in 
the Data Views window and select the Remove button. 
 
To find more information about a view, highlight it in the 
Data Views window and press the Details button. A user 
can change colors and choose a second vertical axis (vs.Y2) 
in this dialog. Settings chosen in this dialog will be 
displayed on screen when the option Show realtime 
updates during acquisition is enabled (see section 6.2.2.1). 

6.3.4 Documentation 

Shortcut: Alt+D 
 
Each individual cycle can have additional documentation 
associated with it. There are two tabs in the documentation 
dialog, Comments and File, Date, Time. 

6.3.4.1 Comments 

The Comments (Fig. 27: Documentation) tab allows user 
entered text data to be associated with each cycle. The 
changes are updated immediately in the file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  29: Documentation 

 

Document title Allows for customization of the graph titles 

Remarks General text comments can be entered in the remarks 
section 

Material In Cutting Force Documentation mode, the user can 
supply a material type comment 
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Tool In Cutting Force Documentation mode, the user can enter 
specific information about the cutting tool under test. 

Cutting Force Parameters vc = cutting velocity [m/min] 
f = feed [mm/rev] 
ap = depth of cut [mm] 
n = speed [rpm] 
vf = feed velocity [mm/min] 
ae = cutter engagement [mm] 

Documentation Mode Specify to document specific cutting force parameters, or 
to document the file using general comments. 

Show Documentation Between acquisition cycles enable the automatic display of 
the documentation dialog box immediately prior to 
acquiring a cycle. 

6.3.4.2 File, Date, Time 

The File, Date, Time tab documents the temporal and 
storage data associated with the original acquisition. 

Folder The directory where the file was initially created 

File The initial name of the file 

Date The original date of the acquisition 

Time The original time of the acquisition 

6.3.5 Edit Labels 

The user can edit the channel labels or unit labels of 
specific channels at any time using the View → Edit Labels 
selection. The channel label or unit entered for any one 
specific channel will be applied to all of the stored cycles 
within the file. The changes are updated immediately in the 
file. 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  30: Edit Labels 

6.3.6 Reset Font to Default 

The font, color, size and style can be changed by double-
clicking the word to be altered in the box. To reset the 
chosen settings to the defaults, select Reset Font to 
Default from the View menu. 



 Reference 
 
 

2825A_002-195e-10.13-Korr.Ex.03  Page 71 
 

6.3.7 Reset Color to Default 

The chosen colors of the signals can be reset to the default 
settings. Choose Reset Color to Default from the View 
menu. 

6.3.8 Zoom  

The Zoom function provides for changing the x-axis and y-
axis scaling parameters for an active graph. The user can 
manually zoom by entering the axis minimum and 
maximum values or graphically zoom using the right 
mouse button. 

6.3.8.1 Manual Zoom 

By default all graphs are scaled to best fit the minimum and 
maximum values of the contained graphs. Selecting View 
→ Zoom presents a dialog box which can be used to set 
the x-axis minimum and maximum values and the y-axis 
minimum and maximum values. The dialog box will remain 
active (button Apply) so that the user can switch to other 
open windows and change the zoom settings. New 
settings will be activated when the OK button is selected. 
The Zoom Off button will restore the graph to the original 
auto scaled values. 
 

 

A zoomed graph will have the word Zoom On in the 
upper left corner of the window.  

 
 
 
 
 
 
 
 
 
 
 
 
Fig.  31: Manual zoom 

6.3.8.2 Graphical Zoom 

It is possible to zoom by clicking the right mouse button 
and dragging to create a Window over the desired zoom 
area of a graph. When the right mouse button is released, 
the graph will be redrawn with the new coordinates. 
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6.3.9 Zoom Out 

Zoom Out will restore the graph to the original auto scaled 
values. Also, by double clicking the right mouse button, the 
graph will return to the original coordinate scaling. Zoom 
Out is deactivated if the graph is currently not zoomed.  

6.3.10 Lock Scaling 

The Lock Scaling function allows successive measurements 
to be represented on the force and time axis to the same 
scale independently of the measured maximum and 
minimum. 

6.3.11 Unlock Scaling 

The Unlock Scaling allows the Lock Scaling function to be 
disabled again.  

6.3.12 Horiz. Grid 

Selecting View → Horiz. Grid from the main menu, or 

selecting the  icon on the toolbar will redraw the active 
graph with horizontal grid lines enabled. Selecting the 
option again will disable the horizontal grid lines. 

6.3.13 Vert. Grid 

Selecting View → Vert. Grid from the main menu, or 

selecting the  icon on the toolbar will redraw the active 
graph with vertical grid lines enabled. Selecting the option 
again will disable the vertical grid lines. 
 

6.3.14 Toolbar 

Selecting View → Toolbar will toggle the visible state of 
the system toolbar. The functional descriptions are: 

 

 File Open 

 Hardware 

 Edit Acquisition 

 Cycle Documentation 

 Setup View 

 Start Acquisition 

 Export Data 

 New View 
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 Edit View 

 Cursor 

 Mean Value (Stats) 

 Drift Compensation 

 Horizontal Grids 

 Vertical Grids 

 Lock Scaling 

 Unlock Scaling 

 Zoom Out 

 Voltmeter 

 Oscilloscope 

 Cascade Views 

 Tile Vertical 

 Tile Horizontal 

 Help 
 

6.3.15 Status Bar 

The status bar can be enabled/disabled from the View → 
Status Bar menu selection. The status bar runs along the 
lower edge of the DynoWare screen. It is separated into 
two sections. The left side of the status bar offers 
information on a topic selected when the mouse is moved 
over a menu bar or tool bar item. The right section of the 
status bar shows the status of the Caps Lock key, the Num 
lock key, and the Scroll lock key. 

 
Fig.  32: Status Bar 
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6.4 Analysis...  

6.4.1 Mean Value  

By selecting Analysis → Mean value from the main menu 

or by clicking the  icon on the toolbar statistical data 
can be displayed on an active y(t) time based graph. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.  33: Mean analysis 
 

The statistical data will appear on the bottom of the graph. 
Statistical data will include: Mean (average) value, 
Maximum value, Minimum Value and Integral between 
two user identified points. 

 
 

 
 
Fig.  34: Sample statistical data 

 
A dashed vertical bar will first appear on the graph along 

with the cursor. This vertical line will track the mouse 
movement to set the starting point for the analysis. Move 
to the desired starting position then left click the mouse. 
Next, a dashed vertical bar will appear on the graph along 

with the cursor. This vertical line will track the mouse 
movement to set the ending point for the analysis. Move 
to the desired ending position then left click the mouse. 
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To change either the starting position or ending position 
and update the statistical data: 
1.) Move the mouse over the dashed vertical cursor line. 

The cursor will change to  
2.) Click the left mouse button and drag the line to a new 

position (cursor will change to when dragging) 
3.) Release the mouse, the statistical data will be updated. 
 
The Mean value analysis can be disabled and the graph 
restored to normal by reselecting the menu choice, or the 
toolbar icon. It is also possible to quit with ESC. 

6.4.2 Cursor Tool 

For the analysis of data it is helpful to display the x- and y-

coordinates. Pressing the toolbar icon  or selecting 
Analysis → Cursor tool from the menu will enable the 
cursor tool. 
 A dashed vertical bar will first appear on the graph along 

with the cursor. Next, a dashed vertical bar will appear 

on the graph along with the cursor.  
 
To change either the starting position or ending position 
and update the cursor tool data: 
1.) Move the mouse over the dashed vertical cursor line. 

The cursor will change to  
2.) Click the left mouse button and drag the line to a new 
position (cursor will change to when dragging) 
3.) Release the mouse, the statistical data will be updated. 
 
The cursor window can be moved anywhere on the 
desktop by left clicking the mouse on the toolbar, and 
dragging to a new location. When activated, the cursor 
tool will apply to all time base graphs y(t).  
 
The cursor tool will display t1 (time at cursor 1), t2 (time at 
cursor 2), dt (t2 – t1), 1/dt (in s-1), 1/dt (in min-1), Y(t1), 
Y(t2), and dY. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



DynoWare Type 2825A… 

Page 76  2825A_002-195e-10.13-Korr.Ex.03 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  35: Cursor tool 

6.4.3 Signal Drift Compensation 

By selecting Analysis → Signal Drift Compensation from 

the main menu or by clicking the  icon on the toolbar, 
data can be adjusted to remove the effect of long-term 
thermal drift and offset. This is accomplished by computing 
a straight line between a starting and ending point, then 
subtracting this line from the selected portion of the data 
set. All data sets on the current time series graph will be 
compensated. 
This function is especially designed for resolving the 
problems of drift in piezoelectric measurement systems. In 
the Operate mode, the signal drifts away with a constant 
slope if the temperature does not change during the 
measurement. However, the direction (if negative or 
positive) is unpredictable. In short measurements or in 
measurements with high forces this drift is usually 
negligible. After very long measurements however this drift 
is clearly visible. Measurement is started before applying 
the force and continues until there is no longer any force 
applied to the tool, the drift is visible as the signal that does 
not fall back to the zero line. 
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The selection of the starting and ending points are 
critical to the accuracy of the compensation. 

 

 

Drift Compensation on will appear in the upper left 
corner the graph to identify the data set as modified. 

 
When selecting drift compensation: 
A dashed vertical bar will first appear on the graph along 

with the cursor. This vertical line will track the mouse 
movement to set the starting point for the compensation. 
Move to the desired starting position then left click the 
mouse.  
Next, a dashed vertical bar will appear on the graph along 

with the cursor. This vertical line will track the mouse 
movement to set the ending point for the compensation. 
Move to the desired ending position then left click the 
mouse. 
The first vertical line should be placed right before the 
rising edge of the force curve – where the signal still lies on 
the zero line. The second line has to be placed where there 
is no longer any force applied, i.e. where the measured 
signal should lie again on the zero line. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.  36: Original Signal 
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Fig.  37: Drift compensation applied 
 
To change either the starting position or ending position 
and update the compensation: 

1.) Move the mouse over the dashed vertical cursor line. 

The cursor will change to  

2.) Click the left mouse button and drag the line to a new 
position (cursor will change to when dragging) 

3.) Release the mouse, the data set will be updated and the 
graph redrawn. 

 
The change is only temporary and can be disabled by 
reselecting the menu choice, or the toolbar icon. Select 
File→ Save Modified File (see Section 6.1.2) to per-
manently apply the changes to the data set. 

6.4.4 Smoothing on… 

Smoothing is used to ‘smooth’ a data set. Smoothing is a 
form of digital filtering. The smoothing options are: 1) 
Moving Mean, 2) Moving Median. Each is discussed in the 
following paragraphs. Select the channels to apply the 
smoothing option from the list presented or press the All 
Channels button to select all available channels. 

 

 

The words 'Smoothing On' will appear in the upper left 
corner of the graph to identify the data set as modified. 
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6.4.4.1 Moving Mean 

A moving mean filter is used to smooth an entire data set 
when no particular frequencies are to be filtered out. This 
type of filter generates a moving average data set from the 
original one, based on a user-specified Window size. The 
window size specifies how many values to the left and 
right of the current value are averaged. The window size 
must be an odd number, because the current value must 
fall in the exact center of the window, with an even 
number of points to the left and right of it (if you enter an 
even number, the calculation is made with the next higher 
number). The average of all values in the window is 
calculated, and this number is used to replace the current 
value. The larger the window size, the more the resulting 
data set is smoothed. The Figure below illustrates both the 
moving mean and the moving median filters. 
 

 

At the beginning and the end when the window size 
would exceed the sampled values, the window size is 
reduced, starting and ending with a window size of 
CEIL(WindowSize/2). 

 
 

 
 
Fig.  38: Moving Mean and Moving Median filters 

 
 

6.4.4.2 Moving Median 

The Moving Median filter is similar to the Moving Mean in 
order that it also uses a moving window. However, this 
method sorts the values within the window and replaces 
the current value with the median value (i.e., the middle 
value in the sorted data window). The moving median type 
filter is good for removing sharp spikes in the data. 
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The change is only temporary and can be disabled by 
reselecting the menu choice, or the toolbar icon. Select File 
→ Save Modified File (see Section 6.1.2) to permanently 
apply the changes to the data set. 
 
  
 

 
 

Kistler measurement equipment is very sensitive. Some-
times what appears to be noise can be "real" measured 
phenomena. Care should be exercised in filtering so as 
not to remove important data. 

 
Below is an example of a "noisy" data set. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.  39: Original data set (no smoothing) 
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Fig.  40: Smoothing on, moving mean (window size = 20) 

6.4.5 Smoothing off 

Selecting Analysis → Smoothing Off will disable any filters 
currently applied to the data set. A check mark on the 
menu will indicate if smoothing is currently on or off. 
 

6.4.6 Filtering on… 

Filtering is used to modify a data set using specific 
frequency content requirements. The type of filter to use 
depends upon the type of modification required. The 
Butterworth filtering options are: 1) Low Pass, 2) High 
Pass, 3) Band Pass, and 4) Band Stop. Each is discussed in 
the following paragraphs. Select the channels to apply the 
filter to from the list present or press the Select All button 
to select all available channels. 
 

 

The words 'Filtering On' will appear in the upper left 
corner of the graph to identify the data set as modified. 

 
 
 
 
 
 
 

mk:@MSITStore:C:\Programme\Kistler\DynoWare\English\DynoWare.chm::/filtering.htm#LowPass#LowPass
mk:@MSITStore:C:\Programme\Kistler\DynoWare\English\DynoWare.chm::/filtering.htm#HighPass#HighPass
mk:@MSITStore:C:\Programme\Kistler\DynoWare\English\DynoWare.chm::/filtering.htm#HighPass#HighPass
mk:@MSITStore:C:\Programme\Kistler\DynoWare\English\DynoWare.chm::/filtering.htm#BandPass#BandPass
mk:@MSITStore:C:\Programme\Kistler\DynoWare\English\DynoWare.chm::/filtering.htm#BandStop#BandStop
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Fig.  41:  Filtered signal 

6.4.6.1 Low Pass 

For a Low Pass filter, the edge frequency is the frequency 
above which all frequencies are attenuated to some 
degree, and below which all frequencies pass unfiltered. 
Essentially, all low frequencies are allowed to pass, and all 
high frequencies are removed. The specified cutoff 
frequency is the –3 db (half power) attenuation point of an 
n-th order Butterworth filter. 
 

6.4.6.2 High Pass 

For a High Pass filter, the edge frequency is the frequency 
below which all frequencies are attenuated to some 
degree, and above which all frequencies pass unfiltered. 
Essentially, all high frequencies are allowed to pass, and all 
low frequencies are removed. The specified cutoff 
frequency is the –3 db (half power) attenuation point of an 
n-th order Butterworth filter. 
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6.4.6.3 Band Pass 

For a Band Pass filter, the lower cutoff frequency and 
upper cutoff frequency define the range in which is 
frequencies are allowed to pass. Outside the range, the 
frequencies are attenuated to some degree. The specified 
cutoff frequencies are the –3 db (half power) attenuation 
points of an n-th order Butterworth filter. 
 

6.4.6.4 Band Stop 

For a Band Stop filter, the lower cutoff frequency and 
upper cutoff frequency define the range in which is 
frequencies are attenuated to some degreed. Outside the 
range, the frequencies are allowed to pass. The specified 
cutoff frequencies are the -3db (half power) attenuation 
points of an n-th order Butterworth filter. 
 

6.4.6.5 Filter Setup 

6.4.6.5.1 Edge Frequencies 

The lower and upper edge frequencies define the -3db 
cutoff frequencies for the various Butterworth filters types. 

6.4.6.5.2 Filter Order 

The filter order specifies the number of taps on the filter. A 
higher filter order requires more computation power but 
provides sharper filtering characteristics. 
 
 
The change is only temporary and can be disabled by 
reselecting the menu choice, or the toolbar icon. Select File 
→ Save Modified File (see Section 6.1.2) to permanently 
apply the changes to the data set. 
 

6.4.7 Filtering off 

Selecting Analysis → Filtering Off will disable any filters 
currently applied to the data set. A check mark on the 
menu will indicate if smoothing is currently on or off. 
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6.4.8 Data Manipulation Offline… 

This function allows you to use basic mathematical 
functions to change data already acquired for each 
channel. The source channels, operation and destination 
channel of the calculation must be specified. 
 

 
 

The output channel is overwritten with the manipulated 
data! 

 

On Activate/deactivate calculation function. 

1. Base First measurand to be processed. 

2. Base Second measurand to be processed. This can also be used 
to enter constants. It is important to conclude the 
numerical entry with RETURN. 

Operation Mathematical operation. The following operations are 
available: addition, subtraction, multiplication, division, 
logg, lnh, exp(e)i, exp(10)j, sqrk and sqrtl. 

Result Channel for outputting result 

Add Adds another function. 

Remove Removes the chosen calculation function. 
  
If data is manipulated in this way the following prompt is 
displayed:  

 
 

 Confirming creates a "*.bak.dwd" file in the folder in 
which the measurement data is saved. This file contains the 
unchanged data, whereas the file with the same name but 
without the ".bak" extension contains the changed data. 

                                                      
gCommon logarithm 
hNatural logarithm 
iPower of e (natural exponential) 
jPower of 10 
kSquare 
lSquare root 
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6.4.8.1 Apply to all cycles in file 

If several cycles have been acquired beforehand, the data 
manipulation can be applied to all cycles of this file. 

6.5 Tools...  

6.5.1 Voltmeter… 

The Voltmeter is a troubleshooting tool that numerically 
displays the voltages at the inputs to the A/D card. 
Selecting Voltmeter from the Tool menu starts the meter. 
Any amplifiers configured for Measure Mode On Start 
Acquisition are switched to the Operate mode 
automatically when the voltmeter is started, and are 
returned to reset when the tool is exited. To stop the 
acquisition, press the Stop button. To restart an acquisition 
press Run. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  42: Voltmeter Tool 
 
The grid shows the channels configured in the system, their 
active state, and the configured label. To enable/disable a 
channel use the On column check box. 
 
The voltage data can be selected to appear in Volts [V] or 
Millivolts [mV]. 
 
The Voltmeter can be run at the same time as the 
Oscilloscope function, but other data acquisition functions 
are disabled while the Voltmeter is active. 
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6.5.2 Oscilloscope… 

The Oscilloscope is a troubleshooting tool that graphically 
displays the voltages at the inputs to the A/D card. 
Selecting Oscilloscope from the Tool menu starts the 
scope. Any amplifiers configured for Measure Mode On 
Start Acquisition are switched to the Operate mode auto-
matically at the start of the oscilloscope, and are returned 
to reset when the tool is exited. To stop the acquisition, 
press the Stop button. To restart data acquisition press 
Run. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig.  43: Oscilloscope tool 
 
The grid shows the channels configured in the system, their 
active state, and the configured label. To enable/disable a 
channel use the On column check box. The channel color is 
displayed in the On column. 
 
The voltage scale and time scale can be selected from the 
Volt / Div. and Sec. / Div. Boxes.  
 
The Oscilloscope can be run at the same time as the 
Voltmeter function, but other data acquisition functions 
are disabled while the Oscilloscope is active. 
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6.6 Options... 

6.6.1 User Mode 

The User Mode allows the software operation to be 
restricted. The default user mode is Supervisor. 

6.6.1.1 Supervisor 

No operation restrictions are made in the Supervisor mode. 
To restrict access to software and device configurations, 
select the Operator mode. The default password is 
"DynoWare" (capital 'D' and 'W', lower case for other 
letters!). 

6.6.1.2 Operator 

No functional settings can be made in this mode (Changes 
to devices configurations, etc. can only be made in the 
supervisor mode). To switch from User mode to operator 
mode a password is required. 

6.6.1.3 Change Password 

 
Fig.  44: Changing password 
 
To change the Operator/Supervisor mode password select 
the Options → User Mode → Change Password menu 
choice. You will need to enter the old password, and enter 
the new password twice identically for the new password 
to be accepted. Passwords are case sensitive. The default 
password is "DynoWare" (capital 'D' and 'W', lower case 
for other letters!). 
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6.7 Window... 

When a graph is open, the Window menu appears in the 
menu bar. The Window menu is for controlling the 
position of the graphs, and is useful when many different 
graphs are open on the screen.  

6.7.1 Cascade 

Arrange all open graphs staggered and overlapping each 
other. 

6.7.2 Tile Horizontal 

Arrange all open graphs to be non-overlapping tiled 
horizontally. 

6.7.3 Tile Vertical 

Arrange all open graphs to be non-overlapping tiled 
vertically. 

6.7.4 Arrange Icons 

Arranges all minimized graphs icons in the lower left corner 
of the application. 

6.7.5 Close All 

Closes all open graphs and files. 

6.7.6 <open windows list> 

Shows a list of all open graphs. Select an item in the list to 
active a specific graph. 
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6.8 Help...  

6.8.1 Help Topics 

The DynoWare help menu is available by selecting Help 
Topics from the Help menu, or by pressing F1 at any time. 
DynoWare uses standard HTML help format through the 
default-configured browser (see section 1.1 for more in-
formation).  

6.8.2 Select Language 

DynoWare offers two languages (German and English). 
Any change is made when the program is started for the 
first time. 

6.8.3 About DynoWare 

The About DynoWare box provides information about the 
running version of the application, and the product type 
number. Be prepared to provide this information when 
requesting technical support. 
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7. Appendix 

7.1 Graphs 

Manipulating data using graphs is simple and quick with 
DynoWare. When a trial is opened one or more graphs 
appear using the default configuration (see Section 6.3.3 
Setup…). The graphs can be edited for content, display, 
and titles. 
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Fig.  45: Typical time based y(t) graph 
 

 

Graph information Area: 
Zoom, Smoothing, Filtering, 
and Drift Compensation 

Zoom selection = right click 
and drag 
Zoom out = double right click 
 

Second y-Axis 

Legend, shows 
label, units, and 
axis 

Cycle move 
forward, cycle move 
backward buttons. 

Main Title (double click to 
edit) 
    

   
    
   

 

Current cycle number Vertical dashed bars for 
drift compensation, 
cursor, or mean value 
calculations. 

Graphical data 
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7.2 Language Selection 

All of the supported languages are displayed in a box by 
pressing Ctrl+Alt+S. You can choose a different language, 
which will be loaded the next time the program is started. 

7.3 Shortcut Key Summary 

Key Command 

F1 Help 
Alt+D View → Documentation 
Alt+E Acquisition → Edit 
Alt+H Acquisition → Hardware 
Alt+S Acquisition → Start 
  
Ctrl+Alt+S Select Language 
Ctrl+P  Print Report 
Ctrl+L Report Layout (not documented) 
  
Ctrl+TAB Cycle through Open Windows (forwards) 
Ctrl+SHIFT+TAB Cycle through Open Windows (backwards) 
  
Right Mouse Drag 
on graph 

Zoom In on graph 

Right Mouse 
Double Click on 
graph 

Zoom Out (if previously zoomed in) 
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7.4 Modifying the Report Logo 

If you want to modify the report print-out to have 
your company logo, perform the following steps: 

 
Replace the file prnlogo.bmp, (by default: 
C:\Programs\Kistler\DynoWare). Name the file of 
your logo prnlogo.  

 
Notes: 

1. The image file extension does not need to be 
entered.  DynoWare will search for "bmp", 
"wmf", "pcx", "tif" and "jpg" image 
extensions automatically (and supports these 
types of images).  

 
2. The recommended image size is 362 (width) 

by 67 (height) pixels. Images will be scaled to 
fit and centered in the logo area of the report.  

 
3. Don’t delete the original prnlogo.bmp file but 

rename it. 

7.5 Example Files 

Filename Description 

messdat.dwd Drilling steel 
messdat1.dwd  
messdat3.dwd General force application 
swept_sine.dwd 1 channel, sine, starting with low and ending with high 

frequency (swept sine), for filter experiments 
 
This data is saved in the following default folder: 
C:\Kistler\DynoWare\Data 
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8. Technical Data of DAQ-Systems Type 5697A 

8.1 General Data 

Dimensions mm 208x70x249 
Weight kg 2,15 
Operating temperature range °C 0 … 50 
Min./max. temperature °C –10/60 

8.2 Power Supply 

Electrical isolation (max. 40 V) between input and supply 
voltage 

Input voltage range VDC 10 … 36 
Power consumption VA 5 

8.3 A/D Conversion 

Number of channels  28m 
Resolution (each channel) bits 16 
Input voltage ranges 
(software-selectable) 

V ±0,1 / ±0,2 / ±0,5 
±1 / ±2 / ±5 / ±10 

Input voltage V ±20 
Sampling rate 
(software-selectable) 

• Max with 1 channel 
• Max with 3 channels 
• Max with 8 channels 
• Max with 14 channels 

kS/s 
 
kS/s 
kS/s 
kS/s 
kS/s 

1 000 
 
1 000 
333 
125 
71 

Error (conversion) % <±0,1 
Zero error 

• in range ±1 V / 
 ±2 V 

• in range 
±5 V / ±10 V 

 
mV 
 
mV 

 
<±1 
 
<±2 

Input noise 
• in range <±1 V 
• in range >±1 V 

 
mVRMS 

mVRMS 

 
<2 
<4 

                                                      
mDynoWare Type 2825A and DynoWare Update Type 
2825E currently only control operation of one multichannel 
charge amplifier on DAQ-System Type 5697. DAQ-System 
Type 5697 is capable to acquire 28 channels maximum. 
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8.4 Connections 

USB 2.0 (high-speed) 
• USB in (uplink, to the 

PC) 
• USB out (downlink, 

unused) 

Type 
 
 
 

 
B, female 
 
A, female 

8.5 Remote Control  

(Digital input and 12 V supply) 
Remote Measure and Trigger with 10 kΩ pullup to +5 V 
 

Connector type  D-sub 9f 
Input level 
 High (/Trigger Input, /Measure Input) 
  Low 

 
VDC 
VDC 

 
>1,5 
<1 

Maximum input voltage VDC ±30 
Supply VDC +12 

 

 

 
 
 



 Measuring Chain Used 
 
 

2825A_002-195e-10.13-Korr.Ex.03  Page 95 
 

9. Measuring Chain Used 

 

 
Fig.  46:  Cable concept for DynoWare Type 2825A…  
 with A/D acquisition card Types 2855A4 and 
 2855A5 
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Fig.  47:  Cable concept for DynoWare Type 2825A…  

with DAQ-System Type 5697A 
 
 
 

 
Fig.  48:  Interface cables 
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